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Overview
This section provides a description of the Rosemount 700XA system, an explanation of the theory of operation, and a glossary of
chromatograph terminology.
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Glossary
Auto zero

The thermal conductivity detector (TCD) is auto zeroed at the start of a new analysis. The operator can also
configure automatic zeroing of the TCD amplifier to take place at any time during the analysis if the
component is not eluting or the baseline is steady. The flame ionization detector (FID) will auto zero at each
new analysis run and can be configured to auto zero anytime during the analysis if the component is not eluting
or the baseline is steady.

Baseline

Signal output when there is only carrier gas going across the detectors. In a chromatogram you should only see
Baseline when running an analysis without injecting a sample.

Carrier gas

The gas used to push the sample through the system during an analysis.

Chromatogram A permanent record of the detector output. A chromatogram is obtained from a personal computer (PC)
interfaced with the detector output through the controller assembly. A typical chromatogram displays all
component peaks, and gain changes. It may be viewed in color as it is processed on a PC display. Tick marks
recorded on the chromatogram by the controller assembly indicate where timed events take place.
Component

Any one of several different gases that may appear in a sample mixture. For example, natural gas usually
contains the following components: nitrogen, carbon dioxide, methane, ethane, propane, isobutane, normal
butane, isopentane, normal pentane, and hexanes plus.

CDT

Component data table

CTS

Clear to send.

DCD

Data carrier detect.

DSR

Data set ready.

DTR

Data terminal ready.

FID

Flame ionization detector. The optional FID may be used in place of a TCD for the detection of trace
compounds. The FID requires a polarization voltage and its output is connected to the input to a high
impedance amplifier, an electrometer. The sample of gas to be measured is injected into the burner with a
mixture of hydrogen and air to maintain the flame.

FPD

Flame photometric detector. The FPD is used to analyze gas compound impurities, such as sulfur,
phosphorous, and metals. When sample gas passes through the hydrogen/air flame the component's
wavelengths emitted are electrically measured. The micro FPD (µFPD) is located in the analyzer's upper
enclosure.

GC

Gas ghromatograph. The GC is a user-configurable analyzer for various process gas applications.

LSIV

Liquid sample injection valve. The optional LSIV is used to convert a liquid sample to a gas sample by vaporizing
the liquid in a heated chamber, so the resulting gas sample can be analyzed.

Methanator

The optional methanator, also known as a catalytic converter, transforms the components that are
undetectable by the FID, carbon dioxide and/or carbon monoxide, into methane by adding hydrogen and heat
to the sample.
Note
Carbon dioxide and/or carbon monoxide components are detectable by the TCD.

Response factor Correction factor for each component as determined by the following calibration:

Retention time

Time, in seconds, that elapses between the start of analysis and the sensing of the maximum concentration of
each component by the detector.

RI

Ring indicator.

RLSD

Received line signal detect. A digital simulation of a carrier detect.

RTS

Request to send.
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RxD, RD, or Sin

Receive data, or signal in.

TCD

Thermal conductivity detector. A detector that uses the thermal conductivity of the different gas components
to produce an unbalanced signal across the bridge of the preamplifier. The higher the temperature, the lower
the resistance on the detectors.

TxD, TD, or Sout

Transmit data, or signal out.

System description
The Rosemount 700XA is a high-speed gas chromatograph (GC) system that is engineered to meet specific field application
requirements based on typical hydrocarbon stream composition and anticipated concentration of selected components. In its
standard configuration, the analyzer can handle up to eight streams: seven sample streams and one calibration stream.
The Rosemount 700XA system consists of two major parts: the analyzer assembly and the electronics assembly. Depending upon
the particular GC, there may also be a third, optional, assembly called the sample conditioning system (SCS).
The electronics and hardware are housed in an explosion-proof enclosure that meets the approval guidelines of various certification
agencies for use in hazardous environments. See the certification tag on the GC for specific details about agency approvals.

Analyzer assembly
The analyzer assembly includes:
■ Columns
■ Thermal conductivity detectors (TCDs)
■ Flame ionization detectors (FIDs)
■ Flame photometric detector (FPD)
■ Preamplifer
■ Preamplifier power supply
■ Stream switching valves
■ Analytical valves
■ Solenoids
Additionally, the Rosemount 700XA can be equipped with a liquid sample injection valve (LSIV) or methanator.
For more information, see Upper compartment.

Electronics assembly
The electronics assembly includes the electronics and ports necessary for signal processing, instrument control, data storage,
personal computer (PC) interface, and telecommunications.
The operator uses the electronics assembly and MON2020 to control the gas chromatograph (GC). Refer to Electronics hardware
for more details.
The GC-to-PC interface provides you with the greatest capability, ease-of-use, and flexibility. You can use MON2020 to edit
applications, monitor operations, calibrate streams, and display analysis chromatograms and reports, which can then be stored as
files on the PC’s hard drive or printed from a printer connected to the PC.
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WARNING
HAZARDOUS AREA EXPLOSION HAZARD
Failure to follow this warning may result in injury or death to personnel.
Do not use a personal computer (PC) or printer in a hazardous area.
Emerson provides serial and Ethernet communication links to connect the analyzer to the PC and to connect to other
computers and printers in a safe area.

Sample conditioning system (SCS)
The optional sample conditioning system is located between the process stream and the sample inlet, which is often mounted
below the gas chromatograph (GC).
The standard SCS configuration includes a stream switching system and filters.

Functional description
A sample probe installed in the process line takes a sample of the gas to be analyzed from the process stream. The sample passes
through a sample line to the sample conditioning system (SCS) where it is filtered or otherwise conditioned. After conditioning, the
sample flows to the analyzer assembly for separation and detection of the gas components.
Figure 1: Gas Chromatography Process Model
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Separation and analysis
The GC separtes the sample gas into its components as follows:
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1. A precise volume of sample gas is injected into one of the analytical columns. The column contains a stationary phase
(packing) that is either an active solid or an inert solid support that is coated with a liquid phase (absorption partitioning).
2. A mobile phase (carrier gas) moves the sample gas through the column.
3. The selective retardation of the components takes place in the column, causing each component to move through the
column at a different rate. This separates the sample into its constituent gases and vapors.
4. A detector located at the outlet of the analytical column senses the elution of components from the column and produces
electrical outputs proportional to the concentration of each component.
Output from the electronic assembly is normally displayed on a remotely located personal computer (PC) or in a distributed control
system (flow computer).
To connect the GC to a PC, use a direct serial line, an optional Ethernet cable, or a Modbus®-compatible communication interface.
Several chromatograms may be displayed via MON2020 with separate color schemes, allowing you to compare present and past
data.
In most cases, it is essential to use MON2020 to configure and troubleshoot the GC. The PC may be remotely connected via
Ethernet, telephone, radio or satellite communications. Once installed and configured, the GC can operate independently for long
periods of time.

Software description
The GC uses two distinct types of software. This enables total flexibility in defining the calculation sequence, report content,
format, type and amount of data for viewing, control, and/or transmission to another computer or controller assembly. The two
types are:
■ Embedded GC firmware
■ MON2020 software
The application configuration is tailored to the customer’s process and shipped on a USB stick. The hardware and software are
tested together as a unit before the equipment leaves the factory.
MON2020 communicates with the GC and can be used to initiate site system setup, i.e., operational parameters, application
modifications, and maintenance.

Embedded GC firmware
The GC’s embedded firmware supervises operation of the Rosemount 700XA through its internal microprocessor-based controller.
All direct hardware interface is via this control software. It consists of a multi-tasking program that controls separate tasks in system
operation, as well as hardware self-testing, user application downloading, startup, and communications. Once configured, the
Rosemount 700XA can operate as a stand alone unit.
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MON2020
MON2020 provides operator control of the Rosemount 700XA, monitors analysis results, and inspects and edits various parameters
that affect the analyzer operation. It also controls display and printout of the chromatograms and reports, and it stops and starts
automatic analysis cycling or calibration runs.
After the equipment/software has been installed and the operation stabilized, automatic operation takes place over an Ethernet
network.
MON2020 is a Windows™-based program that allows you to maintain, operate, and troubleshoot a gas chromatograph (GC).
Individual GC functions that can be initiated or controlled by MON2020 include, but are not limited to, the following:
■ Valve activations
■ Timing adjustments
■ Stream sequences
■ Calibrations
■ Baseline runs
■ Analyses
■ Halt operation
■ Stream/detector/heater assignments
■ Stream/component table assignments
■ Stream/calculation assignments
■ Diagnostics
■ Alarm and event processing
■ Event sequence changes
■ Component table adjustments
■ Calculation adjustments
■ Alarm parameters adjustments
■ Analog scale adjustments
■ Local operator interface (LOI) variable assignments (optional)
Reports and logs that can be produced, depending upon the GC application in use, include, but are not limited to, the following:
■ Configuration report
■ Parameter list
■ Analysis chromatogram
■ Chromatogram comparison
■ Alarm log (unacknowledged and active alarms)
■ Event log
■ Various analysis reports
For a complete list of the GC functions, reports, and logs available through MON2020, consult the MON2020 for Gas
Chromatographs Reference Manual (P/N 2-3-9000-745).

Theory of operation
The following sections discuss the theory of operation for the gas chromatograph, including the engineering principles and
concepts used.
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Note
See Glossary for definitions of the terminology used in this document.

Thermal conductivity detector (TCD)
One of the detectors available on the gas chromatograph (GC) is a TCD, which consists of a balanced bridge network with heat
sensitive thermistors in each leg of the bridge. Each thermistor is enclosed in a separate chamber of the detector block.
One thermistor is designated the reference element, and the other thermistor is designated the measurement element. See Figure
2 for a schematic diagram of the TCD.
Figure 2: Analyzer Assembly with TCD Bridge
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In the quiescent condition, prior to injecting a sample, both legs of the bridge are exposed to pure carrier gas. In this condition, the
bridge is balanced, and the bridge output is electrically nulled.
The analysis begins when the sample valve injects a fixed volume of sample into the column. The continuous flow of carrier gas
moves the sample through the column. As successive components elute from the column, the temperature of the measurement
element changes.
The temperature change unbalances the bridge and produces an electrical output proportional to the component concentration.
The differential signal developed between the two thermistors is amplified by the preamplifier. Figure 3 illustrates the change in
detector electrical output during elution of a component.
Figure 3: Detector Output during Component Elution

A. Detector bridge balanced
B. Component begins to elute from column and is measured by thermistor.
C. Peak concentration of component
In addition to amplifying the differential signal developed between the two thermistors, the preamplifier supplies drive current to
the detector bridge.
The signal is proportional to the concentration of a component detected in the gas sample. The preamplifier provides four different
gain channels as well as compensation for baseline drift.
The signals from the preamplifier are sent to the electronic assembly for component concentration computation, recording, or
viewing on a PC monitor with MON2020.

Flame ionization detector (FID)
Another detector available for the Rosemount 700XA is the flame ionization detector (FID).
The FID requires a polarization voltage, and its output is connected to the input to a high impedance amplifier that is called an
electrometer. The burner uses a mixture of hydrogen and air to maintain the flame. The sample of gas to be measured is also
injected into the burner. See Figure 4 for a schematic diagram of the FID.
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Figure 4: Analyzer Assembly with FID Detector Bridge
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Micro flame photometric detector (µFPD) burner
The flame photometric detector (FPD) is a very sensitive and selective detector for the analysis of sulfur or organophosphorus
containing compounds. The detector is very stable and easy to use.
As the analyte is burned in a hydrogen and air flame, a characteristic wavelength of light is emitted at 394 nm for sulfur. The
emitted light is amplified by the photomultiplier tube (PMT) and processed by the signal processor. The response to phosphorus is
linear and quadratic to sulfur.
The Emerson µFPD solution consists of three key parts: burner, fiber cable, and PMT electronics. The hydrogen and air in the burner
help to burn the sample containing sulfur components. The light emitted from the chemical reaction is then transmitted using the
fiber cable from the oven assembly to the electronics module. The PMT electronics module consists of a 394 nm filter, a
photomultiplier tube (PMT), and all the necessary electronics to digitize the signal. The digtial signal is then transmitted to the main
central processing unit (CPU) using CAN bus.
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Figure 5: µFPD Detector - Front View

A. µFPD burner
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Figure 6: µFPD Burner - Back View

A. µFPD burner
B. Fiber cable
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Figure 7: µFPD Burner - Side View

A. µFPD burner and cable
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Figure 8: µFPD PMT

A. µFPD PMT in the upper enclosure
The detection system in the µFPD uses the reactions of sulfur components in a hydrogen/air flame as a source for analytical
detection. The source of the µFPD's signal is derived from the light produced by an excited molecule created in the flame's
combustion, that is, a photochemical process called chemiluminescence. A thermocouple is fitted to the flame cell to ensure that
the flame is present. If the flame is not detected, the electrometer shuts off the hydrogen to the flame cell. It then supplies a
voltage to the igniter, waits five seconds, and opens the hydrogen shut off valve. The electrometer will make between one and five
ignition attempts if necessary. You can select the number of ignition attempts on the Hardware → Detector screen. If the
electrometer does not succeed in igniting, then the GC shuts off the hydrogen, triggers an alarm, and waits for attention from the
operator.

Related information
Micro flame photometric detector (µFPD)
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Micro flame photometric detector (µFPD) electronics module
The electronics module contains two chambers. The internal chamber contains the photo multiplier tube (PMT) to insulate it from
outside temperature changes. The external chamber is a thermo electric cooler (TEC) controlled chamber, which houses the interal
chamber along with the electronic board that generates high voltage power through the PMT.
Figure 9: Electronics Module, Exploded View

A. Apply thermal compound to both sides.
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Figure 10: Electronics Module, Detailed

A. Maier photonics filter
B. O-ring
On the outside of the external chamber is the electronics main board. This board is the vital part of the µFPD electronics module. It
controls the temperature of the TEC, provides power to the igniter, monitors the flame temperature, and digitizes the PMT signal
and transmits to the main central processing unit (CPU) using CAN bus.
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Liquid sample injection valve (LSIV)
The optional LSIV converts a liquid sample into a gas sample for analysis.
Figure 11: Liquid Sample Injector Valve (LSIV)

Methanator
After all other components have been separated from the sample, carbon monoxide and carbon dioxide, which are normally
present in quantities too small to be detected by the gas chromatograph (GC), can be sent through the optional methanator,
where the two gases are combined with hydrogen to make methane in a heat-generated catalytic reaction. The methanator is also
known as a methanizer or a catalytic converter.

Data acquisition
Every second, the controller assembly takes exactly 50 equally spaced data samples (i.e., one data sample every 20 milliseconds).
As a part of the data acquisition process, groups of incoming data samples are averaged together before the result is stored for
processing. Non-overlapping groups of 50 samples are averaged and stored, and thus reduce the effective incoming data rate to
50/10 samples per second. For example, if N = 5, then a total of 40/5 or 8 (averaged) data samples are stored every second.
The value for the variable N is determined by the selection of a peak width parameter (PW). The relationship is
N = PW
where PW is given in seconds. Allowable values of N are 1 to 63; this range corresponds to PW values of 2 to 63 seconds.
The variable N is known as the integration factor. This term is used because N determines how many points are averaged, or
integrated, to form a single value. The integration of data upon input, before storing, serves two purposes:
■ The statistical noise on the input signal is reduced by the square root of N. In the case of N = 4, a noise reduction of 2 would be
realized.
■ The integration factor controls the bandwidth of the chromatograph signal. It is necessary to match the bandwidth of the input
signal to that of the analysis algorithms in the controller assembly. This prevents small, short-duration perturbations from being
recognized as true peaks by the program. It is therefore important to choose a peak width that corresponds to the narrowest
peak in the group under consideration.

Peak detection
For normal area or peak height concentration evaluation, the determination of a peak's start point and end point is automatic.
The manual determination of start and end points is used only for area calculations in the Forced Integration mode. Automatic
determination of peak onset or start is initiated whenever Integrate Inhibit is turned off. Analysis is started in a region of signal
quiescence and stability, such that the signal level and activity can be considered as baseline values.
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Note
The controller assembly software assumes that a region of signal quiescence and stability will exist.
Having initiated a peak search by turning Integrate Inhibit off, the controller assembly performs a point by point examination of
the signal slope. This is achieved by using a digital slope detection filter, a combination low pass filter and differentiator. The output
is continually compared to a user-defined system constant called Slope Sensitivity. A default value of 8 is assumed if no entry is
made. Lower values make peak onset detection more sensitive, and higher values make detection less sensitive. Higher values (20
to 100) would be appropriate for noisy signals, (e.g., high amplifier gain).
Onset is defined where the detector output exceeds the baseline constant, but peak termination is defined where the detector
output is less than the same constant.
Sequences of fused peaks are also automatically handled. This is done by testing each termination point to see if the region
immediately following it satisfies the criteria of a baseline. A baseline region must have a slope detector value less than the
magnitude of the baseline constant for a number of sequential points. When a baseline region is found, this terminates a sequence
of peaks.
A zero reference line for peak height and area determination is established by extending a line from the point of the onset of the
peak sequence to the point of the termination. The values of these two points are found by averaging the four integrated points
just prior to the onset point and just after the termination points, respectively.
The zero reference line will, in general, be non-horizontal, and thus compensates for any linear drift in the system from the time the
peak sequence starts until it ends.
In a single peak situation, peak area is the area of the component peak between the curve and the zero reference line. The peak
height is the distance from the zero reference line to the maximum point on the component curve. The value and location of the
maximum point is determined from quadratic interpolation through the three highest points at the peak of the discrete value curve
stored in the controller assembly.
For fused peak sequences, this interpolation technique is used both for peaks, as well as valleys (minimum points). In the latter
case, lines are dropped from the interpolated valley points to the zero reference line to partition the fused peak areas into individual
peaks.
The use of quadratic interpolation improves both area and height calculation accuracy and eliminates the effects of variations in the
integration factor on these calculations.
For calibration, the controller assembly may average several analyses of the calibration stream.

Basic analysis computations
Two basic analysis algorithms are included in the controller assembly:
Area Analysis

Calculates area under component peak.

Peak Height Analysis

Measures height of component peak.

Note
MON2020 can perform a variety of other calculations. For more information, see the MON2020 Software for Gas Chromatographs
Reference Manual.
Concentration analysis - response factor
Concentration calculations require a unique response factor for each component in an analysis. These response factors may be
manually entered by an operator or determined automatically by the system through calibration procedures (with a calibration gas
mixture that has known concentrations).
The response factor calculation, using the external standard, is:

where
ARFn

18

Area response factor for component n in area per mole percent
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Arean

Area associated with component n in calibration gas

Caln

Amount of component n in mole percent in calibration gas

Htn

Peak height associated with component n mole percent in calibration gas

HRFn

Peak height response factor for component n

The controller assembly stores calculated response factors to use in the concentration calculations; these response factors are
printed out in the configuration and calibration reports.
Average response factor is calculated as follows:

where
RFAVGn

Area or height average response factor for component n

RFi

Area or height average response factor for component n from the calibration run

k

Number of calibration runs used to calculate the response factors

The percent deviation of new RF averages from old RF average is calculated in the following manner:

where the absolute value of percent deviation has been previously entered by the operator.
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Concentration calculation - mole percentage (without normalization)
After response factors have been determined by the controller assembly or entered by the operator, component concentrations
are determined for each analysis by using the following equations:

where:
ARFn

Area response factor for component n in area per mole percent

Arean

Area associated with component n in unknown sample

CONCn

Concentration of component n in mole percent

Htn

Peak height associated with component n mole percent in unknown sample

HRFn

Peak height response factor for component n

Component concentrations may also be input through analog inputs 1 to 4 or may be fixed. If a fixed value is used, the calibration
for that component is the mole percent that will be used for all analyses.
Concentration calculation in mole percentage (with normalization)
The normalized concentration calculation is:

where:
CONCNn

Normalized concentration of component n in percent of total gas concentration

CONCi

Non-normalized concentration of component n in mole percent for each k component

CONCn

Non-normalized concentration of component n in mole percent

k

Number of components to be included in the normalization

Note
The average concentration of each component will also be calculated when data averaging is requested.
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Equipment description and specifications
Equipment description
The Rosemount 700XA consists of a copper-free aluminum explosion-proof chamber and a front panel assembly. The chamber is
divided into two compartments that together house the gas chromatograph's (GC's) major components. This GC is designed for
hazardous locations.
Figure 12: Rosemount 700XA Gas Chromatograph
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Upper compartment
Lower compartment
Front panel assembly
Mechanical regulators
Sampling system (optional)
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Front panel assembly
The front panel assembly is located on the front section of the lower enclosure and consists of a removable, explosion-proof panel
that shields either a switch panel or a local operator interface (LOI).
Figure 13: 8-stream switch panel (left) and 18-stream switch panel (right)

Switch panel
The switch panel contains a network of on/off switches that allow you to manually control the GC’s stream and analytical valves.
Figure 14: 8-stream Switch Panel

There are two types of switch panels: 8-stream and 18-stream. The 8-stream switch panel is the standard panel, and is used when
the GC has only one heater/solenoid board installed; if two heater/solenoid boards are installed, then the 18-stream switch panel is
used.
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Figure 15: Stream Valves Switches

A valve has the following three operational modes:
■ AUTO - The valve turns on and off according to the Timed Events table that is accessible through MON2020. To set a valve to
AUTO mode, set its switch on the switch panel to the up position.
■ OFF - The valve turns off and remains off until the operational mode is changed. To set a valve to OFF mode, set its switch on the
switch panel to the center position—that is, the switch is neither flipped up nor down.
■ ON - The valve turns on and remains on until the operational mode is changed. To set a valve to ON mode, set its switch on the
switch panel to the down position.
Figure 16: Status LEDs (Top of switch panel)

The switch panels also contain the following status lights that allow you to monitor the GC’s condition:
■ Working - Turns green when the GC is in analysis mode.
■ Unack. Alarm - Turns yellow if there is an unacknowledged alarm.
■ Active Alarm - Turns red if there is an active alarm.
■ FID/FPD - status is detected by MON2020
— status is indicated in MON2020
— flame can be ignited remotely using MON2020 or manually lit
Figure 17: MON2020 Status Indicators

■ Figure 18: Status LEDs (Bottom of switch panel)

CPU - Green light blinks continuously while the GC is running.
■ Valves - Turns green if the valves are functioning automatically; turns red if the valves’ automatic settings have been
overridden.
Note
During GC start up, all LEDs turn on for approximately ten seconds.
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Local operator interface
The optional local operator interface (LOI) gives you in-depth control over the GC’s functions. It has a high resolution color display
that is touch key activated and allows you to operate the GC without a laptop or a PC.
Figure 19: Local operator interface

The LOI includes the following features:
■ Color LCD display with VGA (640 x 480 pixels) resolution
■ ASCII text and graphics modes
■ Adjustable auto-backlighting
■ 8 infrared-activated touch screen keys that eliminate the requirement for a magnetic pen
■ Complete GC status, control, and diagnostics, including full chromatogram display
See Local operator interface (LOI) for more information about operating the LOI.
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Upper compartment
The upper compartment contains the following components:
Valves

There are two types of XA valves: 6-port and 10-port. A GC can have a maximum of six XA valves
consisting of a maximum of four 10-port valves.

Column module

Either capillary or micro-packed.

Thermal conductivity
detector (TCD)

The GC has a maximum of two TCDs as well as a micro flame photometric detector (µFPD), or a
flame ionization detector (FID).

Two heating elements

A top hat heater and a column heater.

One temperature switch for The switch turns off its heating element if the heating element reaches 257 °F (160 °C).
each heating element
Pressure switch

The pressure switch activates when the carrier pressure falls below a predetermined set point.
When activated, the switch triggers a general alarm that displays on the front panel or local
operator interface (LOI) and in MON2020.

Flame ionization detector
(FID)

The optional FID detects trace levels of hydrocarbons.

Micro flame photometric
detector (µFPD)

The optional integral µFPD detects trace levels of sulfur compounds. For more information, refer
to Micro flame photometric detector (µFPD).

Methanator

The methanator, or catalytic converter, is an optional component that converts otherwise
undetectable carbon dioxide and/or carbon monoxide into methane by adding hydrogen and
heat to the sample.

Liquid sample injection
valve (LSIV)

The optional LSIV can vaporize a liquid sample, thereby expanding the GC’s capability to measure
liquids.

Rosemount 700XA
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Lower compartment
The lower compartment consists of the following components:
■ Backplane. The backplane is the GC’s central printed circuit board (PCB). Its main function is as a connection point for the GC’s
specialized plug-in PCBs. The backplane also hosts connections for analog outputs and analog inputs, serial ports and an
Ethernet port.
■ Card cage. The card cage holds the specialized PCBs that plug into the backplane. The following PCBs are housed in the card
cage:
— Preamp board
— CPU board
— Base I/O board
— Heater/Solenoid board
The card cage also has four additional slots for the following optional PCBs:
— A second preamp board
— A second heater/solenoid board
— Two optional communications boards

WARNING
EXPLOSION
The explosion-proof housing should not be opened when the unit is exposed to an explosive environment. If access to the
explosion-proof housing is required, take precautions to ensure that an explosive environment is not present. Failure to do
so may result in injury or death to personnel or cause damage to the equipment.
■ Optional AC/DC power supply.

WARNING
POWER
See power supply label prior to connection. Check the unit power design to determine if it is equipped for AC or DC power.
Applying 110/220 Vac to a DC power input unit severely damages the unit. Failure to check the power supply label may result in
injury or death to personnel or cause damage to the equipment.
Note
The Rosemount 700XA CSA-certified unit is equipped with 3/4-inch NPT-thread adapters.
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Mechanical pressure regulators
The mechanical pressure regulators and gauges are used to set and monitor the pressure of the carrier gas flow through the GC's
columns, as well as the pressure of the FID/FPD air and fuel (H2), if installed.
The regulators and gauges are typically located on front of the analyzer below the electronics enclosure.
Figure 20: Regulators and Gauges
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Specifications
Table 1: Utility Specifications
Type

Specification

Dimensions (without sampling system)

H x W x D: 50 x 40 x 24 in. (127 x 102 x 61 cm)

Weight (without sampling system)

Approximately 150 lb. (68 kg)

Mounting

■ Wall mount (standard)
■ Free-standing (optional)
■ 115 Vac ±10 %

Power

■ 220 Vac ±10 %
■ 50/60 Hz 400 watts running
■ 250 watts start-up
■ Sample gas: 90 psig (620.5 kPa) maximum

Valve actuation

■ Carrier gas: 90 psig (620.5 kPa) maximum
■ Actuation gas: 110 psig (758.4 kPa) maximum
Environment

Thermal conductivity detector (TCD): -4 to 140 °F (-20 to 60 °C)
Flame ionization detector (FID): 32 to 140 °F (0 to 60 °C)
Flame photometric detector (FPD): 32 to 122 °F (0 to 50 °C)

Hazardous area certifications (hardware
dependent)

USA and Canada
■ Class I, Zone 1, Ex/AEx db IIC, Gb T6/T4/T3
■ Class I, Division 1, Groups B, C, and D, IP66
EU ATEX and IECEx
■ Ex db IIC Gb T6/T4/T3
■ Ta = -20 ℃ to 60 ℃
■ SIRA 08ATEX 1328X
■ IECEx SIR 08.0093X
Consult factory for additional product certifications available.

Table 2: Approval Temperature Ratings
T6

Basic system; no alternative options included

T4

Liquid sample injection valve (LSIV) option included

T4

Heat trace option with a maximum 176 ° F (80 ⁰C) temperature switch setpoint

T3

Heat trace option with a maximum 230 °F (110 ⁰C) temperature switch setpoint

28

Emerson.com/Rosemount

July 2020

Analyzer specifications
Type

Specification

Dimensions

■ Basic unit envelope
Width: 15.2 in. (387 mm)
Height: 41.5 in. (1054 mm)
Depth: 19.2 in. (488 mm)
■ Wall mount
Width: 18.2 in. (463 mm)
Height: 41.5 in.(1054 mm)
Depth: 19.2 in. (488 mm)
■ Pole mount
Width: 18.2 in. (463 mm)
Height: 41.5 in. (1054 mm)
Depth: 25.0 in.(635 mm)
■ Floor mount
Width: 18.2 in. (463 mm)
Height: 58.0 in. (1470 mm)
Depth: 19.2 in. (488 mm)
Note
Allow 14 in. (360 mm) additional clearance for removal of dome.

Weight

■ Wall mount : 110 lb. (59 kg)
■ Pole mount: 135 lb. (61 kg)
■ Floor mount: 180 lb. (82 kg)

Tubing

■ 316 stainless steel
■ 316 stainless steel and Kapton® in contact with sample
■ Sulfinert® steel (optional)

Mounting

■ Floor mount
■ Pole mount:
— 2 in. (60.3 mm)
— 3 in. (89.0 mm)
— 4 in. (114.3 mm)
■ Direct wall mount

Power

■ Standard: 24 Vdc (21-30 Vdc operating voltage range); maximum 150 watts
■ Optional: 100-120/240 Vac; 50-60 Hz
Note
Voltage range includes line voltage variations.

Rosemount 700XA
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Electronics hardware
Type

Specifications

Communications (standard)

■ Analog inputs:
— Two standard 4-20 mA inputs filtered with transient protection
■ Analog outputs:
— Six isolated outputs, 4–20 mA
■ Serial communication ports:
— Three termination blocks
— Configurable as RS-232, RS-422, or RS-485
— One D-sub (9-pin) port for PC connection
■ Digital inputs:
— Five inputs, user assignable
— Optically isolated, rated to 30 Vdc at 0.5 A
■ Digital outputs:
— Five outputs, user assignable
— Form C and electro-mechanically isolated, 24 Vdc

Communications (options)

Four expansion slots available for additional communications. Each slot has the capacity to
add one of the following:
■ Four analog inputs (isolated) card
■ Four analog outputs (isolated) card
■ Eight digital inputs (isolated) card
■ Five digital outputs (isolated) card
■ One RS-232, RS-422, or RS-485 serial connection card (up to two maximum)

Ethernet

Two available connections
■ one RJ45 port
■ one four-wire termination – with 10/100 Mbps
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Airless analytical oven
Type

Specification

Valves

6-port and 10-port XA valves; piston-operated diaphragms with pneumatic actuation

Columns

Maximum of 90 ft. (27.4 m) of micro-packed columns; 1/16-inch (1.6 mm) outside
diameter
or
300 ft (91.4 m) of capillary columns

Solenoid actuation

■ 24 Vdc
■ Max 100 psig (6.9 bar)

Temperature control

■ 24 Vdc
■ 2 heaters
■ 2 optional heaters
■ Maximum oven operating temperature of 302 °F (150 °C)

Software
Type

Specification

Software

Windows™-based MON2020™

Firmware

Embedded firmware

Methods

8 timed event tables and 8 component data tables

Analysis clocks

Multiple analysis clock configurations

Peak Integration

■ Fixed time or auto slope and peak identification
■ Update retention time upon calibration or during analysis

Corrosion protection
Type

Specification

Enclosure material

Copper-free and aluminum-coated with industrial grade powder coat suitable for high
humidity and salt-laden environments

Process wetted materials

Stainless steel; if the function of an item excludes the use of stainless steel, such as the
glass rotameter tubes, materials that are resistant to corrosion are used

Electronics

All electronic circuit boards are tropicalized with a clear conformal coating

Archived data storage capabilities
Type

Maximum number of records

Analysis results

86,464 (240 days with 4-minute cycle time)

Final calibration results

370

Calibration results

100 (per row in Analysis Configuration table)

Final validation results

370 (per row in Analysis Configuration table)

Validation results

100 (per row in Analysis Configuration table)
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Type

Maximum number of records

Analysis chromatograms

1,703

Final calibration chromatograms

370 (per row in Analysis Configuration table)(1)

Final validation chromatograms

370 (per row in Analysis Configuration table)(1)

Protected chromatograms

100

Hourly averages
(up to 256 variables(2))

2,400

Daily averages
(up to 256 variables) (2)

365

Weekly averages
(up to 256 variables)(2)

58

Monthly averages
(up to 256 variables)(2)

12

Variable averages
(up to 256 variables)(2)

2,360

Every run
(up to 256 variables)

2,360

Alarm logs

1,000

Event logs

1,000

(1)

(2)

The gas chromatograph (GC) can store final calibration or final validation chromatograms for up to one year, provided that no more than one
calibration or validation is run per day, and the cycle time is less than 15 minutes. If the cycle time exceeds 15 minutes, the oldest final calibration
or validation chromatograms will be deleted to make room for newer ones.
A total of 256 averages, including hourly, daily, weekly, monthly, variable, and every run averages are archived.

Getting started
Emerson started and inspected your gas chromatograph (GC) before it left the factory. Emerson also installed program parameters
and documented them in the GC Config Report furnished with your GC.

Select site
The site you select for the gas chromatograph (GC) is important for measurement accuracy.

Procedure
Install the GC as close as possible to the sample system, but allow for adequate access space for maintenance tasks and
adjustments.

WARNING
HAZARDOUS AREA EXPLOSION HAZARD
Failure to follow this warning may result in injury or death to personnel.
Do not use a personal computer (PC) or printer in a hazardous area.
Emerson provides serial and Ethernet communication links to connect the analyzer to the PC and to connect to other
computers and printers in a safe area.
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Allow a minimum of 3 ft. (0.9 m) in front of the GC for operator access. Ensure that exposure to radio frequency interference (RFI) is
minimal.

Unpack the gas chromatograph (GC)
Unpack and inspect the Rosemount 700XA gas chromatograph upon receipt.

WARNING
LIFTING HAZARD
The Rosemount 700XA is heavy equipment. Failure to observe this warning may cause serious injury to personnel.
Use two people to move the GC.
Observe all proper lifting methods as defined by your site operating procedures.

Procedure
1. Unpack the equipment.
a) Remove the Rosemount 700XA from the shipping crate.
b) Remove the USB memory stick containing the software, applications, Quick Start Guide, and manuals.
Note
The MON2020 version number is located on the back of the USB card.
2. Retain the shipping information.
3. Inspect all parts and assemblies for possible shipping damage.
4. If any parts or assemblies appear to have been damaged in shipment, first file a claim with the carrier.
5. Next, complete a full report describing the nature and extent of the damage and forward this report immediately to your
Emerson Customer Care representative.
6. Include the GC's model number in the report.
Emerson will provide disposition instructions as soon as possible.
If you have any questions regarding the claim process, contact your Emerson Customer Care representative for assistance.
Only proceed to install and start up the GC if all required materials are on hand and free from obvious defects.
7. If your GC is configured with an flame ionization detector (FID) or micro flame photometric detector (µFPD), remove the
vent plug from the FID/µFPD outlet.

CAUTION
The vent plug has a tag attached to it that reads REMOVE VENT PLUGS PRIOR TO OPERATION.
Failure to remove the cap could result in a performance failure or damage to the detector.
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Required tools and components
You will need the following tools and components to install the 700XA
■ Zero grade carrier gas:
— 99.995% pure
— Less than 5 ppm water
— Less than 0.5 ppm hydrocarbons
■ High pressure dual-stage regulator for the carrier gas cylinder
— High side up to 3000 psig (20684.3 kPa)
— Gauge (psig)
— Low side capable of controlling pressure up to 150 psig (1034.2 kPa)
■ Calibration standard gas with correct number of components and concentrations
■ Dual-stage regulator for the calibration gas cylinder with a low pressure side capable of controlling pressure up to 30 psig
(206.9 kPa)
■ Sample probe regulator (fixture for procuring the stream or sample gas for chromatographic analysis)
■ Coalescing filter
■ Membrane filter
■ ⅛-in. stainless steel tubing
— For connecting calibration gas to the GC
— For connecting carrier gas to the GC
— For connecting stream gas to the GC
— Sulfinert tubing required if sulfur components are present in calibration gas
■ Heat tracing, as required for sample transport and calibration lines
■ Miscellaneous tube fittings, tubing benders, and tubing cutter
■ 14 American wire gauage (AWG) (18 metric wire gauge [MWG]) or larger electrical wiring and conduit to provide 120 or 240
Vac, single phase, 50 to 60 Hz, from an appropriate circuit breaker and power disconnect switch. See guidelines in Gas
chromatograph wiring.
■ Digital volt-ohm meter with probe-type leads
■ Flow measuring device
■ Open-end wrenches sized ¼-in., 5/16-in., 7/16-in., ½-in., 9/16-in., and ⅝-in.
■ Torque wrench

Supporting tools and components
WARNING
Failure to follow this warning may result in injury or death to personnel or cause damage to the equipment.
Do not use a personal computer (PC) or printer in a hazardous area.
Emerson provides serial port and Modbus® communciation links to connect the gas chromatograph (GC) to the PC and to
connect to other computers and printers in a safe area.
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■ Use a Windows®-based PC and either a direct or remote communications connection to interface with the GC. See the
MON2020 Software for Gas Chromatographs Reference Manual for more information on specific PC requirements.
■ The GC comes with an Ethernet port on the back plane factory-wired with an RJ-45 connector. Refer to Connect directly to a
personal computer (PC) using the gas chromatograph's (GC’s) Ethernet1 port for more information.

Installation and start-up
Note
Because the Rosemount 700XA is available in different configurations, it is possible that not all of the instructions in this section
apply to your particular gas chromatograph (GC). In most cases, however, to install and set up a Rosemount 700XA, Emerson
recommends that you follow the instructions in the same order as they are presented in this manual.

Installation considerations
Before installing the gas chromatograph (GC):
1.

WARNING
The GC is heavy and has a high potential of injuring personnel or damaging equipment.
Anchor the GC solidly before making electrical connections. Several options for mounting the GC are covered in Mounting
arrangements.

2. Ensure that the connections to the enclosure meet local standards.
3. Use approved seals: either cable glands or conduit seals.
a. Install conduit seals within 3 in. (76.2 mm) of the enclosure.
b. Seal unused openings with approved blanks (plugs). Threads for these openings are M32 x 1.5.
4. Remove any packing materials before powering up the GC.
5.

WARNING
Do not power up an open GC unless the surrounding area is certified non-hazardous.

6.

WARNING
HAZARDOUS AREA EXPLOSION HAZARD
Failure to follow this warning may result in injury or death to personnel.
Do not use a personal computer (PC) or printer in a hazardous area.
Emerson provides serial and Ethernet communication links to connect the analyzer to the PC and to connect to other
computers and printers in a safe area.

Mounting arrangements
The Rosemount 700XA can be installed in one of the following mounting arrangements:
■ Wall mount
■ Pole mount

Rosemount 700XA
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■ Floor mount

WARNING
HEAVY EQUIPMENT
Due to the size, weight, and shape of the gas chromatograph (GC), at least two people are required to safely mount it.
Ensure that you understand the installation procedur before handling the GC and collect the appropriate tools beforehand.
When putting the GC into its final position, be careful to avoid damaging any of the external components or their attachments.
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Wall mount
The simplest mounting arrangement is the wall mount.
If you specify Wall Mount on the sales order, Emerson will ship the gas chromatograph (GC) with a wall mount installation kit. Four
locations on the mounting ears are available for support.

WARNING
HEAVY EQUIPMENT
Until all bolts are tight, ensure that the GC is supported to prevent unforeseen accidents.
Figure 21: Wall Mount

Prerequisites
Pre-install a pair of 7/16-in. (10 mm) diameter bolts with washers on the wall before installing the final pair of bolts.
The first pair of bolts should be approximately 41.625 in. (1055 mm) off the ground, and 13.625 in. (346 mm) apart. Each bolt
should have ⅝ in. (16 mm) of bare length projecting. Drill a second pair of holes 3.56 in. (90.5 mm) above the first.

Procedure
1. Maneuver the GC so that the notches in the mounting ears can be placed over the bolts on the wall and then place the
washers over the bolts.
2. Install the second pair of bolts with washers and then tighten all the bolts.

Pole mount
Prerequisites
The pole mount arrangement uses an additional plate and spacers to allow the necessary clearance for nuts.
If you specify Pole Mount on the sales order, Emerson will provide the necessary hardware.
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WARNING
HEAVY EQUIPMENT
Until all bolts are tight, ensure that the gas chromatograph (GC) is supported to prevent unforeseen accidents.
Figure 22: Pole Mount

Procedure
1. Use the U-bolt to firmly install the large plate on the pole about 44 in. (1120 mm) above the ground.
2. Install the long bolts and spacers.
3. Place nuts and washers on the lower bolts.
4. Install the small plate just tightly enough to hold its position, with the small plate’s U-bolt about 6.875 in. (174.625 mm)
below the large plate’s U-bolt.
5. Hold the matching spacer in place with the bolts installed loosely.
6. Orient the GC so that the notches in the mounting ears can be placed over the lower bolts on the plate and then add the
washers and nuts.
7. Place the nuts with washers on the upper bolts and then tighten all bolts.
8. Adjust the lower bracket to align the bolts with the plate. Tighten the bolts.
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Floor mount
If you specify Floor Mount in the sales order, Emerson sends the arrangement pre-assembled with the gas chromatograph (GC).
The arrangement includes an additional support stand that is intended to be anchored to a floor or an instrument pad. The base
rails have holes that are 13.625 in. (346 mm) apart, side to side, and 16.75 in. (425.5 mm) apart front to back. The holes are ½ in.
(12.7 mm) in diameter and will accept up to 7/16-in. (10 mm) bolts.
Figure 23: Floor Mount
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Gas chromatograph wiring
Wiring precautions
■ All wiring, as well as circuit breaker or power disconnect switch locations, must conform to the CEC or NEC; all local, state, or
other jurisdictions; and company standards and practices.
■ Provide single-phase, three-wire power at 115 or 220 Vac, 50-60 Hz.

NOTICE
If you do not have a single phase, three-wire AC power source, you must purchase an isolation transformer.
■ Locate a power shut-off or disconnect switch in a safe area.
■ Provide the gas chromatograph (GC) and any optionally installed devices with one 20-amp circuit breaker for protection.

CAUTION
POWER
15 amps is the maximum current for 14 American Wire Gauge (AWG).
■ Use multi-stranded copper conductor wire according to the following recommendations:
— For power feed distances up to 250 ft. (76 m), use 14 AWG (18 Metric Wire Gauge), stranded.
— For power feed distances 250 to 500 ft. (76 to 152 m), use 12 AWG (25 Metric Wire Gauge), stranded.
— For power feed distances 500 to 1000 ft. (152 to 305 m), use 10 AWG (30 Metric Wire Gauge), stranded.

Signal wiring
Follow these general precautions for field wiring digital and analog input/output (I/O) lines:
■ Metal conduit or cable (according to local code) used for process signal wiring must be grounded at conduit support points,
because intermittent grounding helps prevent the induction of magnetic loops between the conduit and cable shielding.
■ All process signal wiring should be of a single, continuous length between field devices and the gas chromatograph (GC). If,
however, the length of the conduit runs require that multiple wiring pulls be made, the individual conductors must be
interconnected with suitable terminal blocks.
■ Use suitable lubrication for wire pulls in conduit to prevent wire stress.
■ Use separate conduits for AC voltage and DC voltage circuits.
■ Do not place digital or analog I/O lines in the same conduit as AC power circuits.
■ Use only shielded cable for digital I/O line connections.
— Ground the shield at only one end.
— Shield-drain wires must not be more than two American Wire Gauge (AWG) sizes smaller than the conductors for the cable.
■ When inductive loads (relay coils) are driven by digital output lines, the inductive transients must be diode-clamped directly at
the coil.
■ Any auxiliary equipment wired to the GC must have its signal common isolated from earth/chassis ground.

CAUTION
SIGNAL INTERFERENCE
If you don't follow this precaution, the data and control signals to and from the GC could be adversely affected.
Do not place any loop of extra cable left for service purposes inside the GC purged housing near the conduit entry for AC power.
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Grounding precautions
Follow these general precautions for grounding electrical and signal lines:
■ For shielded signal conducting cables, shield-drain wires must not be more than two American Wire Gauge (AWG) sizes smaller
than the conductors for the cable. Shielding is grounded at only one end.
■ Metal conduit used for process signal wiring must be grounded at conduit support points (intermittent grounding of conduit
helps prevent induction of magnetic loops between the conduit and cable shielding).
■ A single-point ground must be connected to a copper-clad, 10-ft. long, ¾-in. diameter (3 m long, 19.1 mm diameter) steel rod,
which is buried, full-length, vertically into the soil as close to the equipment as is practical.
Note
The grounding rod is not furnished.
■ Resistance between the copper-clad steel ground rod and the earth ground must not exceed 25 Ohms.
■ On ATEX-certified units, the external ground lug must be connected to the customer’s protective ground system via 9 AWG (6
mm2) ground wire. After the connection is made, apply a non-acidic grease to the surface of the external ground lug to prevent
corrosion.
■ The equipment-grounding conductors used between the gas chromatograph (GC) and the copper-clad steel ground rod must
be sized according to your local regulations.

Electrical conduit installation precautions
■ Conduit cutoffs must be cut at a 90-degree angle. Cutoffs must be made by a cold cutting tool, hacksaw, or by some other
approved means that does not deform the conduit ends or leave sharp edges.
■ All conduit fitting-threads, including factory-cut threads, must be coated with a metal-bearing conducting grease prior to
assembly.
■ Temporarily cap the ends of all conduit runs immediately after installation to prevent accumulation of water, dirt, or other
contaminants. If necessary, swab out conduits prior to installing the conductors.
■ Install drain fittings at the lowest point in the conduit run; install seals at the point of entry to the gas chromatograph (GC) to
prevent vapor passage and accumulation of moisture.
■ Use liquid-tight conduit fittings for conduits exposed to moisture.
When a conduit is installed in hazardous areas, follow these general precautions for conduit installation:
■ All conduit runs must have a fitting, which contains explosion-proof sealing (potting) located within 3 in. (76.2 mm) from the
conduit entrance to the explosion-proof housing. The seal should have a minimum IP rating of IP54 or equivalent NEMA®/Type
rating on the conduit sealing devices.
■ The conduit installation must be vapor tight, with threaded hub fittings, sealed conduit joints and gaskets on covers, or other
approved vapor-tight conduit fittings.

WARNING
Failure to observe precautionary signs may result in serious injury or death to personnel.
Observe all precautionary signs posted on the certified explosion-proof equipment. Consult your company's polices and procedures
and other applicable documents to determine wiring and installation practices that are appropriate for hazardous areas.
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Sample system requirements
Line length

If possible, avoid long sample lines. In long s, flow sample lines, velocity can be increased
by decreasing downstream pressure and using by-pass flow via a fast loop.

CAUTION
Stream switching requires a sample pressure of 20 psig (137.9 kPa).
Sample line tubing material

■ Use sulfur-inert tubing for H2S streams; for all other applications, use stainless steel
tubing.
■ Ensure tubing is clean and free of grease.

Dryers and filters

Use small sizes to minimize time lag and prevent back diffusion.
■ Install a minimum of one filter to remove solid particles. Most applications require fineelement filters upstream of the gas chromatograph (GC). The GC includes a 2-micron
filter.
■ Use ceramic or porous metallic type filters. Do not use cork or felt filters.

NOTICE
Install the probe/regulator first, immediately followed by the coalescing filter and then the
membrane filter. See Carrier gas installation and maintenance for a recommended natural
gas installation.
Pressure regulators and flow
controllers

■ Use stainless steel wetted materials.

Pipe threads and dressings

Use PTFE tape. Do not use pipe thread compounds or pipe dope.

Valving

■ Install a block valve downstream of sample takeoff point for maintenance and
shutdown.

■ Parts should be rated for sample pressure and temperature.

■ The block valve should be a needle valve or cock valve type, of proper material and
packing, and rated for process line pressure.
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Electrical installation
NOTICE
Emerson switches off central processing unit (CPU) boards before shipping to preserve their batteries. Before installing the CPU
board, be sure to switch it on..
Figure 24: CPU Board

A. SW7 battery power ON

Connect power supply

WARNING
ELECTRICAL HAZARD
Failure to follow this warning may result in injury or death to personnel or cause damage to equipment.
Ensure that the 24 Vdc input power source is switched Off before connecting the wires.
Ensure that the 24 Vdc power supply is safety extra low voltage (SELV) compliant by suitable electrical separation from other
circuits.
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CAUTION
EQUIPMENT DAMAGE
Failure to observe this precaution may damage equipment.
Check the GC prior to wiring to determine if it is equipped for DC power.

Procedure
1. Locate the plug-together termination block inside the electronics enclosure.
Figure 25: 24 Vdc power connection on the back plane

2. Bring the two leads in through one of the two possible entries on the lower compartment. Connect to the termination plug
provided with the GC.
Figure 26: Wiring Entries on the Under Side of the Lower Enclosure
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Wire Color

+ (positive)
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Attribute

Wire Color

– (negative)

black

Note
Do not disconnect the factory-installed ground wire.
The backplane board that connects to the 24 Vdc is protected from lead reversal by the use of blocking diodes.
If the red (+) and black (-) leads are inadvertently reversed, no damage will occur; however, the system will not have power.
3. Connect the DC power leads to the power disconnect switch that should be properly fused.
The recommended fuse size is 8 amps.
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Connect optional AC/DC power converter

WARNING
Failure to follow this warning may result in injury or death to personnel or cause damage to equipment.
Check the gas chromatograph (GC) prior to wiring to determine if it is equipped for optional AC power.

Procedure
1. Locate the plug-together termination block inside the electronics enclosure, atop the power supply and adjacent to the card
cage.
Figure 27: AC/DC Termination Block

WARNING
Failure to follow this warning may result in injury or death to personnel or cause damage to equipment.
Do not connect the AC power leads without first ensuring that the AC power source is switched Off.

CAUTION
Failure to observe this precaution may cause damage to equipment.
Do not apply electrical power to the GC until all interconnections and external signal connections have been verified and
proper grounds have been made.
AC wiring is usually color coded as:
Label

Wire color

Hot (H)

Brown or black

Neutral (N)

Blue or white

Ground (G)

Green with yellow tracer or green

2. Bring the power leads in through the left entry on the bottom of the enclosure.
3. If necessary at remote locations, connect the GC chassis ground wire to an external copper ground rod.
See Grounding precautions regarding electrical and signal grounding.

Connect gas lines
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Procedure
1. Remove the plug from the 1/16 in. sample vent tubing marked SV1 that is located on the flow panel assembly.
■ If desired, connect the sample vent lines to an external, ambient pressure vent. If the vent line is terminated in an area
exposed to wind, protect the exposed vent with a metal shield.
■ Use ¼-in. or ⅜-in. tubing for vent lines longer than 10 ft. (3 m).
At this stage in the installation, the measure vent (MV) lines (labeled on the side of the gas chromatograph [GC]) should
remain plugged until the GC has been checked for leaks. For regular operation, however, the MV lines must be unplugged.
Note
Do not discard the vent line plugs. They are useful when leak-checking the GC and its sample or gas line connections.
2. Connect the carrier gas to the GC. The carrier gas inlet is labeled Carrier In and is a ¼-in. T-fitting.

WARNING
EXPLOSION HAZARD
Failure to follow this warning may result in injury or death to personnel.
Do not turn on sample gas until you have completely checked the carrier lines for leaks.
■ Use stainless steel tubing to convey carrier gas.
■ Use a dual-stage regulator with high-side capacity of 3,000 psig (20,684.3 kPa) and low-side capacity of 150 psig
(1,034.2 kPa).
■ Carrier gas is fed from two bottles (see Carrier gas installation and maintenance) for carrier gas plumbing.
3. Connect calibration standard gas to the GC.
When installing the calibration standard gas line, ensure that the correct tubing connection is made.
■ Use ⅛-in. stainless steel tubing to connect calibration standard gas unless the application requires treated tubing.
■ Use a dual-stage regulator with low-side capacity of up to 30 psig (206.8 kPa).
4. Connect sample gas stream(s) to the GC.
■ Use ⅛-in. stainless steel tubing, as appropriate, to connect sample gas.
■ Unless stated otherwise in the product documentation, ensure that the pressure of the calibration and sample line is
regulated at 15 psig to 20 psig (103.4 to 137.9 kPa).

Postrequisites
After all lines have been installed, proceed with leak-checking the carrier and sample lines. See Leak checking and purging for first
calibration.

Maximum effective distance by communication protocol type
The table below lists the maximum distance at which the indicated protocol can transmit data without losing effectiveness. If
longer runs are required, the use of a repeater or other type of extender will be necessary to maintain the protocol's efficiency.
Communication protocol

Maximum distance

RS-232

50 ft. (15.24 m)

RS-422/RS-485

4,000 ft. (1,219.2 m)

Ethernet (CAT5)

300 ft. (91.44 m)
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RS-485 serial port terminating resistors
To ensure correct communication with all hosts, place a 120-ohm terminating resistor across the GC serial port terminals on the
RS-485 link. On a multi-dropped link, install the terminating resistor on the last controller link only.

Connect directly to a personal computer (PC) using the gas chromatograph's (GC’s) Ethernet1 port
Procedure
1. Plug one end of the Ethernet cable into the PC’s Ethernet port and the other end into the GC’s RJ45 socket on on the
backplane.
2. Locate switch at SW1 on the backplane. Place SW1 in the On position.
Note
The GC can be connected (or remain connected) to the local network on Ethernet2 on the backplane while the DHCP
feature on Ethernet1 is being used.
This starts the GC’s DHCP server feature. The server typically takes approximately 20 seconds to initialize and start up.
3. Wait for 20 seconds and then do the following to ensure that the server has provided an IP address to the PC:
a) From the PC, go to Start → Control Panel → Network Connections....
The Network Connections window lists all dial-up and local area network (LAN)/high-speed Internet connections
installed on the PC.
b) In the list of LAN / high speed Internet connections, find the icon that corresponds to the PC-to-GC connection and
check the status that displays beneath the Local Area Connection.
It should show the status as Connected. The PC is now capable of connecting to the GC. See Connect to the gas
chromatograph (GC) using MON2020.
If the status is Disconnected, it may be that the PC is not configured to accept IP addresses; therefore, do the
following:
4. Right-click the Properties icon.
The Local Area Connection Properties window displays.
5. Scroll to the bottom of the Connection list box and select Internet Protocol (TCP/IP).
6. To configure the PC to accept IP addresses issued from the GC, select the Obtain an IP address automatically and Obtain
DNS server address automatically check boxes.
7. Click OK to save the changes and to close the Internet Protocol (TCP/IP) Properties window.
8. Click OK to close the Local Area Connection Properties window.
9. Return to the Network Connections window and confirm that the appropriate icon’s status reads Connected.
If the icon still reads Disconnected refer to Troubleshoot DHCP connectivity issues.

NOTICE
If you power cycle the GC, then you will lose connectivity. After the GC initializes completely, refer to Troubleshoot DHCP
connectivity issues to learn how to repair the connection.

Connect to the gas chromatograph (GC) using MON2020
To connect to the GC using the RJ45 Ethernet1 connection, do the following:

Procedure
1. Start MON2020.
The Connect to GC window displays.
2. Locate the default Direct-DHCP under the GC Name column.
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This GC directory is created automatically when MON2020 is installed. You can rename the GC, but do not change the IP
address that it references, 192.168.135.100.
3. Click the associated Ethernet button.
MON2020 prompts you to enter a user name and password.
4. Enter your user name and password.
5. MON2020 connects you to the GC.
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Troubleshoot DHCP connectivity issues
Use the following tips to troubleshoot server connectivity issues:

Procedure
1. Ensure that the gas chromatograph (GC) is up and running.
2. Check that the SW1 switch is in the On position.
3. Check the following connections:
a) If you are using a Ethernet straight-through cable, ensure that the personal computer (PC) has an Ethernet network
interface card with auto-MDIX.
b) If your Ethernet network interface card does not support auto-MDIX, ensure that you are using an Ethernet crossover
patch cable.
c) Check to see if the GC's central processing unit (CPU) board link lights are on.
see Figure 28. The three Ethernet1 light-emitting diodes (LEDs) are located on the front bottom edge of the card. If
link lights are off, then check your connections. (see Figure 28).
Figure 28: CPU Board Link Lights

A. CPU board
B. Ethernet link lights
4. Do the following to ensure that your network adapter is enabled:
a) Go to Start → Control Panel → Network Connections....
b) Check the status of the Local Area Connection icon. If the status appears as Disabled, right-click the icon and select
Enable from the context menu.
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5. Do the following to try to repair the network connection:
a) Go to Start → Control Panel → Network Connections....
b) Right-click the Local Area Connection icon and select Repair from the context menu.

Connect directly to a personal computer (PC) using the gas chromatograph's (GC's) serial port
The GC’s serial port at J23 on the backplane allows a PC with the same type of port to connect directly to the GC. This is a useful
feature for a GC that is located in an area without Internet access; all that is needed is a PC running Microsoft Windows®, a
notebook computer, and a straight-through serial cable.
To set up the PC for the direct connection, do the following:

Procedure
1. Install the communications cable between two computers:
a) Navigate to Start → Control Panel and select the Phones and Modem Options icon.
The Phones and Modem Options dialog window displays.
b) Select the Modem tab and click Add….
The Add Hardware Wizard displays.
c) Select the Don’t detect my modem; I will select it from a list check box and then click Next.
d) Click Have Disk.
The Install from Disk dialog window appears.
e) Click Browse
The Browse dialog window displays.
f) Navigate to the MON2020 install directory (typically C:\Program Files (x86)\Emerson Process Management\MON2020)
and select Daniel Direct Connection.inf.
g) Click Open.
You return to the Install from Disk dialog window.
h) Click OK.
You return to the Add Hardware Wizard.
i) Click Next.
j) Select an available serial port and click Next.
The Hardware Installation dialog window displays.
k) Click Continue Anyway.
After the driver is installed, you return to the Add Hardware Wizard.
l) Click Finish.
You return to the Phones and Modems dialog window. The Daniel Direct Connect modem should be listed in the
Modem column.
2. Start MON2020 and do the following to create a GC connection for the Daniel Direct Connection modem:
a) Select GC Directory from the File menu.
The GC Directory window displays.
b) Select Add from the GC Directory window’s File menu.
A New GC row is added to the bottom of the table.
c) Select the New GC text and type a new name for the GC connection.
d) Select the new GC’s Direct check box.
e) Click the Direct button located at the bottom of the GC Directory window.
The Direct Connection Properties window displays.

Rosemount 700XA

51

July 2020
f) Select Communications cable between two computers (COM n) from the Port dropdown menu.
Note
The letter n stands for the COM port number.
g) Select 57600 from the Baud Rate dropdown menu.
h) Click OK to save the settings.
You return to the GC Directory window.
i) Click OK to save the new GC connection and to close the GC Directory window.
3. Connect one end of the direct connect cable to the GC’s serial port at J23 on the backplane.
4. Connect the other end of the direct connect cable to the PC’s corresponding serial port.
5. Select Connect… from the Chromatograph menu.
The Connect to GC window displays.
6. Click Direct to connect to the GC using the serial cable connection.

Connect directly to a personal computer (PC) using the gas chromatograph's (GC’s) wired Ethernet
terminal
The Rosemount 700XA has a wired Ethernet terminal at TB11 on the backplane that you can connect to with a static IP address. All
that is needed is a PC, typically a notebook computer, and a two-wire, twisted pair, CAT5 Ethernet cable with one of its plugs
removed to expose the wires.
Figure 29: Crimped CAT5 Cable

Note
The GC can be connected (or remain connected) to the local network on Ethernet2 on the backplane while the DHCP feature is
being used.
Figure 30: Wired Ethernet Terminal Block on the Backplane
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Procedure
1. Use the following schematics as a guide to wiring the GC via its four wire connector at TB11.
Figure 31 shows the traditional wiring scheme. Figure 32 shows how to wire a CAT5 cable without the RJ45 plug.
Figure 31: Field Wiring to TB11

Figure 32: CAT5 Wiring to TB11

2. Once you have wired the cable to the Ethernet terminal, plug the other end into a PC or a wall jack.
See Assign a static IP address to the gas chromatograph (GC) to continue configuring the GC.

Assign a static IP address to the gas chromatograph (GC)
Procedure
1. Start MON2020 and log in to the GC using a direct Ethernet connection.
For more information, refer to Connect directly to a personal computer (PC) using the gas chromatograph's (GC’s)
Ethernet1 port.
2. Select Application → Ethernet ports....
The Ethernet Ports window displays.
3. Depending upon the Ethernet port to which you want to assign a static IP address, do the following:
a) The Ethernet port at TB11: Enter the appropriate values in the Ethernet2 IP Address, the Ethernet 2 Subnet, and the
Default Gateway fields.
b) The RJ45 Ethernet port at J22: Enter the appropriate values in the Ethernet1 IP Address, the Ethernet1 Subnet, and
the Default Gateway fields.
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Note
See your information technology (IT) staff to obtain IP, subnet, and gateway addresses.
Important
To configure a Ethernet IP address using the local operator interface (LOI), refer to Figure 146.
4. Click OK.
5. Log off the GC.
6. Access the backplane, which is located in the GC’s lower enclosure.
Figure 33: Port Locations on the Backplane

7. If you are setting up a static IP address for the Ethernet1 port at J22, and you also intend to connect to your company’s local
area network, do the following:
a) Locate the set of dip switches, labeled 1 and 2 , at SW1 on the backplane.
SW1 is located directly beneath the Ethernet port at J22 .
b) Move dip switch 1 to its left position (Off).
This disables the DHCP server.
8. To connect to the GC, do the following:
a) Start MON2020 and select File → GC Directory....
The GC Directory window displays.
b) Select Add.
MON2020 adds a new GC profile to the end of the table.
Note
You can name the GC’s profile as well as add a short description.
c) Select the new profile and click Ethernet... Enter the GC’s static IP address in the IP address field.
d) Click OK.
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The Ethernet Connection Properties for New GC window closes.
9. Click Save to save the new profile.
10. Click OK to close the GC Directory window.
11. Select Chromatograph → Connect... to connect to the GC or click .
The Connect to GC window displays. The newly created GC profile should be listed in the table.
12. Locate the new GC profile and click the Ethernet button that is associated with it.
The Login window displays.
13. Enter a User Name and User Pin and click OK.

Wiring the discrete digital inputs and outputs
The GC’s backplane has five discrete outputs and five discrete inputs.
If more than five digital outputs are required, see Wire a ROC800 digital output (DO) module to add the ROC800 Digital Output
Module.
Wire the discrete digital inputs

DANGER
ELECTRIC SHOCK
Failure to observe this precaution will cause serious personal injury or death.
The equipment operates using mains voltage that is dangerous to life. Make sure that the circuit breakers are set to OFF and tagged
off before

WARNING
EXPLOSION HAZARD
Failure to de-energize the analyzer may cause an explosion and severly injure personnel.
Do not open the enclosure unless the area is known to be non-hazardous or unless all devices within the enclosure have been
de-energized.
To connect digital signal input lines to the GC, see Engineering drawings and do the following:

Procedure
1. Disconnect power to the analyzer and allow the components to cool for at least five minutes.
2. Open the electronics enclosure door and access the backplane.
3. Make the digital input wiring connections on the backplane at TB7.
Note
The discrete digital input terminals on the backplane are self-powered. Devices connected to the digital input will be
powered by the gas chromatograph's (GC's) dedicated isolated 24 V power supply.
Note
The discrete digital input terminals are optically isolated from the GC's other circuitry.
4. Route digital in/out (I/O) lines away from the sensitive detector lines (on the left side of the backplane) and away from the
analog inputs and outputs.
There are connections for five digital inputs on the backplane at TB7, as indicated in the following table.
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Table 3: Discrete Digital Inputs TB7
TB7

Function

Pin 1

DI1

Pin 2

DI-RTN

Pin 3

DI2

Pin 4

DI-RTN

Pin 5

DI3

Pin 6

DI-RTN

Pin 7

DI4

Pin 8

DI-RTN

Pin 9

DI5

Pin 10

DI-RTN

Wire a ROC800 digital input (DI) module
To connect the ROC800 DI module to a field device, do the following:

Procedure
1. Expose the end of the wire to a maximum length of ¼-in. (6.4 mm).
Note
Twisted-pair cables are recommended for in/out (I/O) signal wiring. The module’s terminal blocks accept wire sizes between
12 and 22 American wire gauge (AWG). Allow some slack when making connections to prevent strain.

CAUTION
Failure to follow this precaution may cause a short circuit and damage equipment.
Allow only a minimum exposure of bare wires to prevent short circuits.
2. Insert the exposed end into the clamp beneath the termination screw.
3. Tighten the screw.
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Figure 34: Typical Wiring

Table 4: ROC800 Discrete digital wiring
Terminal

Label

Definition

1

1

CH 1 Positive

2

2

CH 2 Positive

3

3

CH 3 Positive

4

4

CH 4 Positive

5

5

CH 5 Positive

6

6

CH 6 Positive

7

7

CH 7 Positive

8

8

CH 8 Positive

9

COM

Common

10

COM

Common
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Wiring the discrete digital outputs
The discrete outputs are located on TB3, which is a 15-pin connector, and have five Form-C relays on the back plane. All contact
outputs have a rating of 1A at 30 Vdc.
Refer to drawing BE-22175 in List of engineering drawings - Rosemount 700XA
Figure 35: TB3 on the Backplane

Table 5 lists the discrete digital output function for each pin on the TB3 connector.
Table 5: Discrete Digital Outputs - TB3
TB3

Function

Pin 1

NC1
DIG_OUT NC1

Pin 2

ARM1
DIG_OUT ARM1

Pin 3

NO1
DIG_OUT NO1

Pin 4

NC2
DIG_OUT NC2

Pin 5

ARM 2
DIG_OUT ARM2

Pin 6

NO2
DIG_OUT NO2

Pin 7

NC3
DIG_OUT NC3

Pin 8

ARM3
DIG_OUT ARM3

Pin 9

NO3
DIG_OUT NO3
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Table 5: Discrete Digital Outputs - TB3 (continued)
TB3

Function

Pin 10

NC4
DIG_OUT NC4

Pin 11

ARM4
DIG_OUT ARM4

Pin 12

NO4
DIG_OUT NO4

Pin 13

NC5
DIG_OUT NC5

Pin 14

ARM5
DIG_OUT ARM5

Pin 15

NO5
DIG_OUT NO5

Note
Form-C relays are single-pole double-throw (SPDT) relays that have three positions: normally closed (NC); an intermediate position,
also called the make-before-break position (ARM); and normally open (NO).
Optional discrete digital inputs (DI)
When plugged into one of the optional card slots in the card cage, the Emerson ROC800 DI card provides eight additional discrete
digital inputs. The discrete digital inputs can monitor the status of relays, open-collector or open-drain type solid-state switches,
and other two-state devices. For more information, see ROC800-Series Discrete Input Module at Emerson’s ROC 800-Series website at
Emerson.com/en-us/catalog/emerson-roc800-series
Figure 36: Optional Digital in/out (I/O) Modules
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Wire a ROC800 digital output (DO) module
Figure 37: Discrete Digital Output Wiring

DO
1+
CONTROL

COM

2+
COM

3+

DISCRETE DEVICE
EXTERNALLY POWERED

COM

4+
COM

5+
COM

5 CHAN

Terminal

Label

Definition

1

1+

Positive discrete output

2

COM

Discrete output return

3

2+

Positive discrete output

4

COM

Discrete output return

5

3+

Positive discrete output

6

COM

Discrete output return

7

4+

Positive discrete output

8

COM

Discrete output return

9

5+

Positive discrete output

10

COM

Discrete output return

To connect the ROC800 DO module to a field device:

Procedure
1. Expose the end of the wire to a maximum length of ¼ in. (6.4 mm).
Note
Twisted-pair cables are recommended for I/O signal wiring. The module’s terminal blocks accept wire sizes between 12 and
22 American wire gauge (AWG). Allow some slack when making connections to prevent strain.
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CAUTION
ELECTRICAL HAZARD
Failure to follow this precaution may cause a short circuit and damage equipment.
Allow only a minimum exposure of bare wires to prevent short circuits.
2. Insert the exposed end into the clamp beneath the termination screw.
3. Tighten the screw.

Wiring the analog inputs
All Rosemount 700XA gas chromatographs (GCs) have at least two analog inputs. An additional four analog inputs are available
with a ROC800 AI-16 card (see Wire a ROC800 digital output (DO) module) that can be installed into one of the optional slots in the
card cage.
Analog inputs on the backplane
There are two analog input connections on the backplane at terminal block 10 (TB10).
Table 6: Analog Inputs TB10
TB10

Function

Pin 1

+AI_1

Pin 2

-AI_1

Pin 3

+AI_2

Pin 4

-AI_2
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Analog inputs settings
Figure 38 shows how to wire two analog inputs (TB10).
Figure 38: Customer Wiring for Analog Inputs

A.
B.
C.
D.
E.
F.
G.
H.

Backplane
Analog inputs
Analog input 1
Analog input ground
Analog input 2
Cable
Customer devices
Customer 4-20 mA outputs

Use the Hardware → Analog Inputs menu in MON2020 to configure the analog inputs.
Select the input type for an analog input
You can set an analog input to either voltage (0-10 V) or current (4-20 mA) .

Procedure
1. Select Hardware → Analog Inputs....
The Analog Inputs window displays.
2. To set the analog input to current, select mA from the mA/Volts drop-down list for the appropriate analog input; to set the
analog input to voltage, select Volts from the mA/Volts drop-down list for the appropriate analog input.
3. Click Save to save the changes and keep the window open, or click OK to save the changes and close the window.
Typical wiring for line-powered transmitters
The following drawing shows the most common wiring plan for supplying power to two 4-20 mA transmitters, such as pressure
sensor transmitters.
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Figure 39: Typical Wiring for Line-Powered Transmitters

A.
B.
C.
D.

Back plane
Customer transmitter
Analog inputs
Transmitter 4-20 mA output

Optional analog inputs (AI)
When plugged into one of the optional card slots on the card cage, the ROC800 AI-16 card provides four additional analog inputs.
The AI channels are scalable, but are typically used to measure either a 4-20 mA analog signal or a 1-5 Vdc signal. If required, the
low end of the AI module’s analog signal can be calibrated to zero. For more information, see Analog Input Modules (ROC800-Series
at Emerson's ROC800-Series website.
Wire an ROC800 AI-16 module

CAUTION
ELECTROSTATIC DISCHARGE (ESD)
Operators and technicians must wear an electrostatic wrist strap when handling printed circuit cards to prevent shorting the boards
through static electricity.

Rosemount 700XA

63

July 2020
Figure 40: Typical ROC800 Wiring

A. 1-5 volt device, externally powered
B. 1-5 volt device, ROC800 powered
C. Current loop device 4-20 mA, ROC800 powered
To connect the ROC800 AI-16 module to a device:

Procedure
1. Expose the end of the wire to a maximum length of ¼ in. (6.4 mm).
Note
Twisted-pair cables are recommended for in/out (I/O) signal wiring. The module’s terminal blocks accept wire sizes between
12 and 22 American wire gauge (AWG). Allow some slack when making connections to prevent strain.

CAUTION
ELECTRICAL HAZARD
Exposing bare wires may cause a short circuit and damage equipment.
Only allow a minimum exposure of bare wires.
2. Insert the exposed end into the clamp beneath the termination screw.
3. Tighten the screw.
There are two dip switches on the terminal block side of the module that can be used to set a 250 Ω resistor in or out of
circuit for each analog input.
To put an analog input’s resistor in circuit, flip the appropriate dip switch to I; to put an analog input’s resistor out of circuit,
flip the appropriate dip switch to V.
Calibrate a ROC800 AI-16 module

Prerequisites
To calibrate the ROC800 AI-16 module you must have a personal computer (PC) with the ROCLINK™ 800 Configuration software
installed and open.
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See Emerson’s ROC 800-Series for details, downloads and manuals.

Procedure
1. Go to Configure → I/O → RTD Points → Calibration.
2. Select an analog input.
3. Click Update to request one value update from the input.
4. Click Freeze to stop the values of the input from being updated during calibration.
Note
If you are calibrating a temperature input, disconnect the resistance temperature device (RTD) sensor and connect a decade
box or comparable equipment to the RTD terminals of the ROC card.
5. Click Calibrate.
6. Enter a value for Set Zero after stabilization.
7. Enter a value for Set Span after stabilization.
8. Enter values for up to three Midpoints one at a time or click Done if you are not configuring midpoints.
9. Click OK to close the main calibration window and unfreeze the associated inputs. To calibrate the inputs for another analog
input, return to Step 1.

Analog output wiring
The Rosemount 700XA has at least six analog outputs. An additional four analog inputs are available with an ROC800 AO card that
can be installed into one of the optional slots in the card cage.
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Factory settings for analog output switches
Figure 41 shows how to wire up to six devices to the analog outputs that are located on the backplane. It also shows how to wire up
to two analog inputs.
Figure 41: Wiring for Six Analog Outputs

Wire customer externally-powered analog outputs
It is possible to furnish power to each analog output while maintaining isolation between channels.
Consult Figure 42 before wiring a customer-powered device:

Procedure
1. Use Figure 42 to provide power wiring to each analog output while maintaining isolation between channels.
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Figure 42: Wiring for Customer-Powered Analog Outputs

2. The settings for the analog outputs connections, located on the backplane are necessary to provide power to each analog
output while maintaining isolation between channels.
Optional analog outputs
When plugged into one of the optional card slots on the card cage, the ROC800 AO card provides four additional analog outputs.
Each channel provides a 4 to 20 mA current signal for controlling analog current loop devices.
For more information, see Emerson's ROC 800-Series website.
Connect ROC800 analog output (AO) module to a field device

Procedure
1. Expose the end of the wire to a maximum length of ¼ in. (6.4 mm).
Note
Emerson recommends using twisted-pair cables for in/out (I/O) signal wiring. The module’s terminal blocks accept wire
sizes between 12 and 22 American wire gauge (AWG). Expose minimal bare wire to prevent short circuits. Allow some slack
when making connections to prevent strain.
2. Insert the exposed end into the clamp beneath the termination screw.
3. Tighten the screw.
4. Close the electronics enclosure door and apply power to the gas chromatograph (GC).
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5. Run MON2020 and connect to the GC.

Configure analytical train
Use the Analytical Train Configuration window for multiple analysis clocks to assign the valve, digital outputs (DO), and detectors to
each train and then assign each train to its respective analysis clock.

Procedure
1. Assign the usage of valves and DO to Analyzer# on Hardware → Valves, Hardware → Detectors and Hardware → Discrete
Outputs screens.
2. Open the Application → Analytical Train Configuration screen.
3. Click Discrete Output and Valves. Assign the respective DOs, valves, and detectors to each analytical train.
The valves and DOs are assigned with Usage as Analyzer# displayed on this screen. All available detectors are also displayed
on this screen. You cannot configure the same detector, valve or DO to multiple trains.
4. On the Application → Timed Event screen, filter the configured events as per train selection by selecting the Train#
checkbox.

Configure analysis clock
Use this feature to configure a single analysis or multiple analyses.
One analysis can be considered as one virtual gas chromatograph (G) that has independent Sample Loop, Analytical Path, and Timed
Event tables.
Multiple analyses can run independently to analyze multiple streams at the same time. The number of analyses are set at factory
per the mechanical configurations.
Mechanical
configurations

Description

Trains 1 - 6

The configured trains that are used by the analysis

Default Stream Sequence Sets the default sequence to be used by the indicated analysis during auto-sequencing. To create a
new stream sequence or to edit an already-created sequence, click Stream Sequence .
Purge Duration

The amount of time, in seconds, to purge the stream before starting an analysis, calibration, or
validation run. The default value is 60 SEC. Purging allows sample gas to flow through the sample loop
prior to beginning the run.

Energy Value Check

If enabled, the GC analyzes the calibration gas as an unknown stream and computes its energy value.
The GC then compares this value to the Cal Gas Cert CV and determines if the calibration gas's energy
value is within the CV Check Allowed Deviation. If it isn't, the GC triggers the Energy Value Invalid
alarm. The following conditions must be met before the GC can perform a EV Check:
■ The EV Check flag in the System window must be enabled.
■ At least one stream must be set up in the Streams window as a calibration stream, and the Auto
flag for this stream must be enabled.
The EV Check is performed under any of the following circumstances:
■ During a warm start that follows a power failure during normal operation. The GC waits for the
heater and electronic pressure controller to reach their respective set points and stabilize. It then
analyzes the calibration gas as an unknown stream and identifies the peaks. If all the component
peaks are identified, the GC computes the calibration gas' energy value and performs the EV
Check.
■ After a successful calibration, the GC computes the gas' energy value with the new response
factors and performs the EV Check
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1. Press Insert to add a new analysis.
2. Press Delete to delete an analysis.

Related information
Configure analytical train

Leak checking and purging for first calibration
CAUTION
EQUIPMENT DAMAGE
Failure to clean and dry the tubing may compromise the integrity of the analyzer or its warranty.
Make sure all tubing is clean and dry internally.
Prior to installation, blow the tubing free of internal moisture, dust, or other contaminants.
Verify that all electrical connections are correct and safe and then turn the gas chromatograph (GC) on.

Check the gas chromatograph (GC) for leaks
Prerequisites
Leak checking carrier and calibration gas lines requires power and a personal computer (PC) connected to the GC.
Note
Refer to the analyzer's drawing documentation package that shipped with the GC for leak checking and identifying vents.
Emerson tested the GC and fittings for leaks at the factory prior to shipment.

Procedure
1. Plug the measure vent (labeled MV) vent line if it is open.
Leave the SV or sample vent line open or unplugged.
2. Slowly pressurize each line in turn; then block-in the line, making sure the pressure holds.
For example, the carrier gas line should be slowly brought up to 100 psig (689.5 kPa) ± two percent with the dual-stage
regulator at the carrier gas cylinder, and the actuation pressure should be 100 psig (689.5 kPa) maximum.
3. After two minutes, shut the carrier gas bottle valve and observe the high side regulator gauge on the carrier gas bottle.
a. The gauge should not bleed down more than 100 psig in ten minutes.
b. If helium is lost at a faster rate, leaks are usually found between the carrier gas bottle and the analyzer. Check and
tighten all connections, as well as the dual-stage regulator.
4. When the leak check is complete, reopen the helium bottle valve. Remove the plug from the MV line.
5. Shut the metering valve below the rotameter on the front of the flow panel.
Leave the metering valve shhut for now; you will reopen it later during initial purging and the analyzer's first calibration.
6. Repeat the procedure with sample gas and stream gas.
Note
Do not use a liquid leak detector, such as Snoop®, on the valves or components in the oven.
Note
Refer to the Flow Configuration schematic in the documentation packet that shipped with the GC for detailed instructions on
plugging the flame ionization detector (FID) and flame photometric detector (FPD) vents..
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Plugged lines, columns, and valves
If the lines, columns, or valves are plugged, check the gas flow at valve ports.
For a reference, use the flow diagram in the drawing package that shipped with your gas chromatograph (GC), and remember
these points about flow diagrams:
■ Port-to-port flow paths are indicated by solid or dashed lines on the valve symbol in the drawing.
■ A dashed line indicates flow direction when the valve is On, i.e., energized.
■ A solid line indicates flow direction when the valve is Off, i.e., not energized.

Purge carrier gas lines
Prerequisites
Purging carrier and calibration gas lines requires power and a personal computer (PC) connected to the gas chromatograph (GC).

Procedure
1. Ensure that the vent line plugs have been removed and the vent lines are open.
2. Ensure that the carrier gas bottle valve is open.
3. Set the GC side of the carrier gas to 115 psig (792.9 kPa).
4. Turn on the GC and the PC.
5. Start MON2020 and connect to the GC.

NOTICE
Consult the MON2020 Software for Gas Chromatographs Reference Manual for information about connecting to a GC.
6. Select Hardware → Heaters....
The Heaters window displays.
Figure 43: Heaters Window

7. Allow the GC system temperature to stabilize and the carrier gas lines to become fully purged with carrier gas, which usually
takes at least an hour.
The temperature values for the heaters should indicate that the GC is warming up.
The Status column displays OK.
8. Select Control → Auto Sequence....
For more information about this function, refer to the MON2020 Software for Gas Chromatographs Reference Manual.
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Note
You can also performStep 6 through Step 8 with the local operator interface (LOI).
Important
A continuous operation without sample gas for a period of four to eight hours (or overnight) is recommended, during which
no changes should be made to the settings described in Step 1 through Step 7.

Purge calibration gas lines
Prerequisites
Purging calibration gas lines requires power and a personal computer (PC) connected to the gas chromatograph (GC).

Procedure
1. Ensure that the carrier gas lines have been fully purged and that the sample vent plugs have been removed.
2. Close the calibration gas bottle valve.
3. Fully open the block valve associated with the calibration gas feed.
Refer to the MON2020 Software for Gas Chromatographs Reference Manual for instructions on selecting streams.
4. Open the calibration gas bottle valve.
5. Increase the outlet pressure to 15 psig (103.4 kPa), plus or minus five percent, at the calibration gas bottle regulator.
6. Close the calibration gas bottle valve.
7. Let both gauges on the calibration gas bottle valve bleed down to 0 psig (0 kPa).
8. Repeat Step 4 through Step 7 five times.
9. Open the calibration gas bottle valve.
Note
This applies to vapor calibration standard.

WARNING
Failure to follow the safety instructions may cause injury to personnel.
Observe all safety precauations defined in the calibration gas Safety Data Sheet (SDS), especially for hazardous locations.

Start up the system
Procedure
1. For system startup, run a single-stream analysis of the calibration gas.
a) Verify the calibration stream is set to Auto.
b) Use MON2020 to run a single stream analysis on the calibration stream. Once proper operation of the GC is verified,
halt the analysis by selecting Control → Halt....
Note
Example - use the MON2020 → Control → Single Stream → Calibrate menu path and select the associated analysis
stream.
Unless stated otherwise in the product documentation, ensure that the pressure of the calibration and sample line is
regulated at 10 to 30 psig (68.9 to 206.8 kPa). 15 psig (103.4 kPa) is recommended.
c) Validate calibration gas and retention times and run a manual calibration.
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d) Go to MON2020 → Application → Component Data and select the associated stream. Check the Component Data
table for calibration gas validation information and retention times.
e) Go to MON2020 → Control → Calibration and select the analysis stream to run a manual calibration. Select the
Purge stream for 60 seconds checkbox and Normal calibration type radio button; then click OK.
Refer to the MON2020 Software for Gas Chromatographs Reference Manual for more information.
2. Select Control → Auto Sequence... to start auto sequencing of the line gas stream(s).
Refer to the MON2020 Software for Gas Chromatographs Reference Manual for more information.
The gas chromatograph (GC) begins the auto sequence analysis.

Operation and maintenance
Warning and precautions
WARNING
Failure to observe the precautionary signs posted on the Rosemount 700XA can result in injury or death to personnel or cause
damage to the equipment.
Observe all precautionary signs posted on the GC.

CAUTION
Failure to follow this precaution can result in damage to the card.
Turn off the gas chromatograph (GC) before removing a card from the card cage assembly.

Start a 2-point calibration
The 2-point calibration process calculates an exponential power fit that the gas chromatograph (GC) uses to accurately analyze a
sample stream with a flame photometric detector (FPD).

Prerequisites
The 2-Point calibration process requires two calibration gases that will be used to generate the data for the exponential power fit
calculation. While both calibration gases should have the same components, one of the calibrations gases, called the low
calibration gas (LCG), should have a lower concentration of the components than the other calibration gas, which is called the high
calibration gas (HCG). The GC can then compute the coefficients for the 2-point (2-Pt) exponential power fit by doing a single-level
calibration on these individual LCG and HCG streams.

Procedure
1. Start MON2020 and press F6 to open the Component Data window.
2. Change the Calib Type for the target component to 2 pt Calib.
3. For the target component, select the component data table (CDT) that is associated with the LCG from the 2 Pt Calib High
CDT drop-down list.
4. For the target component, select the CDT that is associated with the HCG from the 2 Pt Calib High CDT drop-down list.
5. Run a single stream analysis on the stream associated with the LCG until the readings stabilize.
6. Run a forced calibration on the stream associated with the LCG.
7. Run a normal calibration on the stream associated with the LCG.
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8. Run a single stream analysis on the stream associated with the HCG until the readings stabilize.
9. Run a forced calibration on the stream associated with the HCG.
10. Run a normal calibration on the stream associated with the HCG.
The GC is ready to analyze the sample or validation stream using the 2 Pt Exp with the response factor that was calculated
during the LCG and HCG runs.
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Troubleshooting and repair
The most efficient method for maintaining and repairing the Rosemount 700XA is a component-replacement concept that allows
you to return the system to operation as quickly as possible.
Use troubleshooting test procedures to identify sources of trouble, such as printed-circuit assemblies, valves, etc., and replace
them with parts in known good working order.

Routine maintenance
The Rosemount 700XA will perform accurately for long periods with very little attention (except for maintaining the carrier gas
cylinders).
It helps to keep a bi-monthly record of certain parameters to assure that the gas chromatograph (GC) is operating to specifications.
Fill out the maintenance checklist should be filled out bi-monthly, date it, and keep it on file for access by maintenance technicians
as necessary. This gives a historical record of the operation of the Rosemount 700XA, enables a maintenance technician to
schedule replacement of gas cylinders at a convenient time, and allows quick troubleshooting and repair when necessary.
Also, create a diagnostic file, which contains calibration and analysis chromatograms, alarm and event logs, analysis reports, and
the complete configuration file, and file it with the checklist, furnishing a positive dated record of the Rosemount 700XA. You can
compare these chromatograms and reports to the chromatograms and reports run during the troubleshooting process.
Before contacting Customer Care, connect to your GC and save the diagnostics data file. From MON2020 → Tools → Save
Diagnostic Data, save the diagnostic data file.
MON2020 prompts you to send an email to Customer Care (at gc.csc@emerson.com) with the diagnostic data file.

Maintenance checklist
Print the sample maintenance checklist in Figure 44 for your records.
If you have a problem, please complete the checklist first and have the results available, as well as the sales order number, when
calling your Emerson Customer Care representative for technical assistance. The sales order number is on the nameplate located on
the front of the Rosemount 700XA. Emerson files the chromatograms and reports archived when your gas chromatograph (GC) left
the factory by this number.
Note
To find the default measurements for the parameters on the checklist, use MON2020 to view the GC’s parameter list.
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Figure 44: Sample Maintenance Checklist
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Routine maintenance procedures
At least bi-monthly, create and save a diagnostic data file and check carrier and calibration gas supplies.

Diagnostic data file
The diagnostic data file is a small data file that contains the last chromatogram from each stream, the final calibration
chromatogram, calibration reports, validation reports, protected chromatograms, the maintenance log, and the event log. To
create the diagnostic data file in MON2020, go to Tools → Save Diagnostic Data... and save the file to your computer.

Service programs
Rosemount Lifecycle Services offers maintenance service programs that are tailored to fit specific requirements.
Contracts for service and repair can be arranged by contacting Lifecycle Services at the address or telephone number on the back of
this manual or visiting the website at: Lifecycle Services

Precautions for handling printed circuit (PC) assemblies
Printed circuit assemblies contain complementary metal-oxide-semiconductor (CMOS) integrated circuits, which can be damaged
if the assemblies are not properly handled.

CAUTION
EQUIPMENT DAMAGE
Do not install or remove the printed circuit assemblies while power is applied to the gas chromatograph (GC).
Keep electrical components and assemblies in their protective (conductive) carriers or wrapping until ready for use.
Use the protective carrier as a glove when installing or removing printed circuit assemblies.
Wear an electrostatic discharge (ESD) strap to prevent static discharge when installing or removing printed circuit assemblies.
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Figure 45: SW7 on the Central Processing Unit (CPU) Board

A. SW7 switch (ON is towards the dot.)
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Flame ionization detector (FID) configuration
When connected to the gas chromatograph (GC) via MON2020, select Hardware → Detectors to access the Detectors dialog.
Refer to the MON2020 Software for Gas Chromatographs Reference Manual for additional configuration details.
Figure 46: MON2020 - Detectors Window

Halt the analysis: Control → Halt (F3).
Configure the following fields from the Detectors dialog:
■ FID Ignition - Manual or Automatic
■ Ignition Attempts
■ Wait Time Bet (between) Tries
■ Igniter On duration
■ Flame On Sense Temp
■ Flame Out Sense Temp
■ Electrometer Voltage
Note
If the FID does not appear in the Detectors window your GC may not be fitted with an FID.

Replace the central processing unit (CPU)
Procedure
1. Save the gas chromatograph (GC) configuration file. In MON2020, go to File → Save Configuration (to PC).
2. Power down the GC.
3. Open the GC cover.
4. Remove the clear plastic cover that holds the boards in place.
5. Remove the CPU board.
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CAUTION
ELECTROSTATIC DISCHARGE (ESD) HANDLING PRECAUTIONS REQUIRED
CPU boards are sensitive electronic devices.
Do not ship or store near strong electrostatic, electromagnetic, or radioactive fields.
Use an antistatic wrist strap (or ESD wrist strap) when handling the boards.
6. On the new CPU board, set up switches as shown in the following image:
Figure 47: CPU Switch Settings

A.
B.
C.
D.

Turn SW7 ON (toward the dot).
Turn SW3 OFF (away from the dot).
Turn SW4 OFF (away from the dot).
Turn SW6 OFF (away from the dot).

Note
Rosemount 700XA GCs are tagged with CPU board part number 7A00555G02.
7. Install the new CPU board in the card cage.
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Ensure the board is seated firmly in place.
8. Place the clear plastic cover back over the boards.
9. Close the GC cover.
10. Power up the GC and connect to it through MON2020.
11. In MON2020, go to Chromatograph → View/Set Date_Time. Set the date and time for the GC.
See the MON2020 Software for Gas Chromatographs Reference Manual for more information.
12. In MON2020, go to Tools → Cold Boot. Cold boot the GC.
The GC reboots automatically and disconnects from MON2020.
13. Wait for the GC to reboot.
14. Reconnect to the GC using MON2020.
15. In MON2020, go to File → Restore Configuration (to GC). Use the configuration file you saved in Step 1 or use the last
known good configuration.
16. Wait for the heaters to stabilize.
17. Go to Control → Auto Sequence to auto sequence the GC.

Recover the central processing unit (CPU)
Follow this procedure if you have accidentally installed a CPU board with the switch in the Off position or if unusual things are
happening to the analyzer and you suspect a corrupt CPU.
Important
Do not use a config file saved from a suspect CPU.

Procedure
1. Power down the gas chromatograph (GC).
2. Open the GC cover.
3. Remove the cover from the card cage.
4. Remove the CPU board from the card cage.
5. Ensure the switches on the CPU board are as shown in Figure 48.
6. Set the CPU board aside for ten minutes to bleed the contents of the battery backed random access memory (RAM).
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7. On the CPU board, set up the switches as shown in Figure 48.
Figure 48: CPU Board Switch Settings

A. SW7
8. Install the CPU board.
Ensure that the board is firmly seated in the card cage.
9. Install the cover on the card cage.
10. Close the GC cover.
11. Power up the GC
12. Connect to the GC using MON2020.
13. Go to Chromatograph → View/Set Date Time.
14. Set the date and time for the GC. Save your changes.
15. Go to Tools → Cold Boot. Cold boot the GC.
The GC reboots automatically and disconnects from MON2020.
16. Wait for the GC to boot.
17. Connect to the GC using MON2020.
18. Go to File → Restore Configuration (to GC) and restore configuration to the GC.
19. Wait for the heaters to stabilize.
20. In MON2020, go to Control → Auto Sequence to return the GC to normal operation.

Repairing and maintaining the valves
Only minimal valve repair and maintenance is required (e.g., replacing the diaphragms).
Required tools for valve maintenance
The tools required for performing repair and general maintenance on the Rosemount XA Series valve assemblies are:
■ Torque wrench, scaled in foot-pounds
■ ½-in. socket for 10-port valves
■ 7/16-in. socket for 6-port valves
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■ ¼-in. open-ended wrench
■ 5/16-in. open-ended wrench
■ 5/32-in. Allen wrench
Valve replacement parts
Replacement parts required for each Rosemount XA Series valves consist of the following parts:
■ Diaphragm kit 6-port XA valve (PN 2-4-0710-248)
■ Diaphragm kit 10-port XA valve (PN 2-4-0710-171)
Figure 49: XA Series Valves

Overhaul a valve
Note
Rosemount valves have a lifetime warranty. Replacement factory-built XA Series valves are available. Call your local Emerson
Customer Care representative for more information.
If you are overhauling a 6-port valve, refer to drawing #CE-22260; If you are overhauling a 10-port valve, refer to drawing
#CE-22300. Both drawings are available in Engineering drawings.

Procedure
1. Shut off the carrier and sample gas streams entering the unit.

WARNING
HOT SURFACES
Failure to allow the analyzer to cool may cause burns from hot surfaces in the enclosure.
Power down the GC and allow it to cool for at least five minutes.
2. Disconnect tubing and fittings that attach to the valve from other locations.
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3. Loosen the valve’s torque bolt.
Figure 50: Valve

A. Torque bolt
4. Holding the lower piston plate, pull the valve straight off the block.
The alignment pins may stick slightly.
5. Remove and discard the old valve diaphragms and gaskets.
6. Clean the sealing surface as required using a non-lint-forming cloth and isopropyl alcohol. Blow the sealing surface with
clean, dry instrument air or carrier gas.
Note
Dirt, including dust and lint, can cause troublesome leakage.
Do not use an oil-based cleaner on the valve.
7. Replace the old diaphragms and gaskets, in the same order, with the new ones supplied.
8. Reassemble the valve using the following steps:
a) Align the pins with holes in the block and push the valve assembly into place.
b) Tighten the valve’s torque bolt.
The 6-port valve requires 20 ft./lb. of torque; the 10-port valve requires 30 ft./lb. of torque.
c) Reinstall the valve using the two mounting screws and reconnect all fittings and tubing.
Replace solenoids
You can replace the oven system solenoids and/or the stream switching solenoids.

WARNING
EXPLOSION
Failure to follow this warning may result in injury or death to personnel or cause damage to equipment.
Disconnect all electrical power to the gas chromatogaph (GC) and ensure the area is free of explosive gases.

Procedure
1. Remove the thermal cover from the upper enclosure.
2. Loosen the ultem thumb screw and tilt the oven on its side to gain access to the solenoids that are located on the underside
of the ultem.
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3. Loosen the screws holding the solenoid in place and remove the solenoid.
4. Place a small amount of silicone grease on the target device (pneumatic block, four-way stream block, etc.) where the
solenoid is to be placed.
The grease ensures a tight seal.
5. Tighten the screws to hold the solenoid in place.
6. Place the oven upright.
7. Tighten the ultem thumb screw.

Repairing and maintaining the detectors
When a thermal conductivity detector (TCD) fails to perform normally, you may need to replace it.
Signs that a TCD may be faulty include, but are not limited to, the following:
■ A chromatogram with a wandering or drifting baseline
■ A chromatogram with a noisy baseline
■ A chromatogram with a no peaks
■ No chromatogram
A test for a faulty TCD involves measuring the resistance of each filament using a multimeter. A pair of thermistors should give the
same resistance reading; therefore, if a thermistor reading is significantly different from the reading of its mate, replace the pair.
Otherwise, the TCD bridge will be unbalanced, noisy, and drifty.
Required tools for thermal conductivity detector (TCD) maintenance
A flat-head screwdriver is required for removing and replacing TCDs. Use a multimeter to test the thermistor pair.
Thermal conductivity detector (TCD) replacement parts
Consult the parameter list that was provided with the gas chromatograph (GC) for the thermistor kit required to replace one TCD. A
new thermistor seal (2-6-5000-084) is also required.
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Figure 51: TCD

A. Gas connector
B. TCD block
C. TCD 1 and TCD 2 retainer nuts and thermistor leads
Replace a thermal conductivity detector (TCDO)
See drawing DE-22143 in List of engineering drawings - Rosemount 700XA.

WARNING
EXPLOSION HAZARD
Failure to de-energize the analyzer may cause an explosion and severely injure personnel.
Do not open the enclosure unless the area is known to be non-hazardous or unless all devices within the enclosure have been
de-energized.
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WARNING
Failure to follow this warning may result in injury or death to personnel or cause damage to the equipment.
Disconnect all electrical power to the gas chromatograph (GC) and ensure the area is free of explosive gases.

Procedure
1. Disconnect all power to the GC.
2. If you have not already done so, remove the explosion-proof dome and the thermal cover.
3. Unscrew and remove the TCDs from the TCD block and the gas connectors.
Figure 52: Components of a TCD

A. Gas tubing connector
B. TCD block
C. TCD 1 and TCD 2 retaainer nuts and thermistor leads
4. Loosen the two retainer nuts.
5. Use a flat head screw driver and remove the four TCD termination block screws.
6. The TCD thermistors are held within the TCD block by the retainer nut. To replace the thermistor, do the following:
a) Unscrew and release the thermistor leads from the termination block.
b) Unscrew the retainer nut from the TCD block.
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c) Remove the PTFE seals as well as the thermistor and its wires from the retainer nut.
d) Remove the PTFE shields from the old thermistor wires and install on the new thermistor wires.
e) Insert a new PTFE seal into the TCD block.
f) Thread the thermistor through the retainer nut.
g) Screw the retainer nut back into the TCD block.
Ensure a tight fit (quarter turn after finger tight); otherwise a potential leak path might open.
h) Reconnect the thermistor leads to the termination block, taking care to reconnect the thermistor leads to the
corresponding terminal block screws.
Note
The thermistors are a matched pair (2-5-1611-003) and must be replaced as such. Repeat Step 6 for each thermistor in a
pair.
Note
Tighten the block screws with a torque wrench to 20 in.-oz.
7. Reconnect the gas tubings.
Make sure tubing is properly seated and reattach the TCD housing with the four screws.
8. Replace the thermal cover and explosion-proof dome.
9. Apply power to the GC.

Remove the flame ionization detector (FID)
The FID has no replaceable parts. If it has damage (such as as broken resistance temperature device [RTD] or igniter coil) you will
need to remove and replace the FID.

WARNING
EXPLOSION HAZARD
Failure to de-energize the analyzer may cause serious injury or death to personnel.
Do not open when energized or when an explosive atmosphere may be present.
Keep cover tight while circuits are live.
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Figure 53: FID

A.
B.
C.
D.
E.
F.

Termination board
Cap
Ground shield cover
Mounting bracket
Vent connector
Exhaust tube

Procedure
1. Disconnect all power to the gas chromatograph (GC).
Allow at least 10 minutes for the components to cool down.
2. Remove the explosion-proof dome and the thermal hood.
3. Remove the screw connecting the termination board to the FID cap.
4. Remove the two screws from the mounting bracket.
5. Unscrew and remove the vent connector.
Note
Use a backing wrench on the bolt fronting the FID cap when removing the vent connector.
6. Remove the screw from the top of the FID assembly.

CAUTION
ELECTROSTATIC DISCHARGE (ESD)
Operators and technicians must wear an electrostatic wrist strap when handling printed circuit cards to prevent shorting the
boards through static electricity.
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Postrequisites
To reassemble the FID, refer to Reassemble the flame ionization detector (FID). The final step is to flip the FID switch to the ON
position.

Reassemble the flame ionization detector (FID)
Procedure
1. Insert the FID into the mounting bracket and secure with the two block screws.
2. Grasp the edges of the FID board and align with the six socket tubes that extend into the pins in the cap.
3. Replace the screw at the top of the FID assembly.
4. Tighten the tubing nut connector, securing the FID exhaust tube.
5. Screw in the tubing nut connectors located at the base of the FID.
6. Install the explosion-proof cover over the FID assembly and secure to the base with eight bolts.
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Replace igniter/thermocouple assembly
Figure 54: Igniter/Thermocouple Assembly Front View

A.
B.
C.
D.
E.
F.
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Bulkhead nut
Screws and washers
Fitting
Bulkhead nut
Igniter/thermocouple assembly
Igniter connector
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Figure 55: Igniter Side View

A.
B.
C.
D.
E.
F.
G.
H.

Fitting
Screws and washers
Bulkhead nut
Black plastic edge
Igniter/thermocouple assembly
Port A
Port H
Port S

Procedure
1. Loosen the bulkhead nut (Figure 54, A).
2. Detach the igniter connector (Figure 54, F).
3. Remove the screws and washers (B) from the plastic bracket.
4. Rotate the micro flame photometric detector (µFPD) burner around the bulkhead nut (Figure 54, A) until there is enough
room to remove the igniter/thermocouple assembly.
5. Loosen the nut (Figure 54, D); then slide the igniter/thermocouple assembly and ferrule (not shown here) out of the µFPD
burner through the fitting.
6. Slide the bulkhead nut (Figure 54, D) and a new ferrule on the new igniter/thermocouple assembly. Then slide the µFPD
burner through the fitting (Figure 54, C).
7. Align the black plastic edge of the igniter (Figure 55, D) with the end of the nut (Figure 54, D) and gradually tighten the nut
(Figure 54, D) to the fitting (Figure 54, C). Keep pushing the ignitor toward the burner while tightening the nut (Figure 54,
D). The back edge has to be flush with the end of nut (Figure 54, D) when secured. Tighten the nut (Figure 54, D) to 4 in.-lb.
Do not overtighten the nut (Figure 54, D).
8. Rotate the µFPD burner back to its original position. Finger tighten the screws and washers (B).
9. Tighten the bulkhead nut (Figure 54, A) to 20-in. lb.
10. Secure the screws and washers (B).
11. Reconnect the ignitor connector (Figure 54, C).
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Troubleshoot igniter/thermocouple assembly
Figure 56: Igniter/Thermocouple Assembly Drawing

A.
B.
C.
D.

Purple, igniter
Black, igniter
White, thermocouple
Red, thermocouple

Figure 57: Igniter/Thermocouple Assembly Photo

A. Back plate
B. Connectors
■ Resistances measured between pins 1 and 2 shall be 0.5 - 1.2 ohms.
■ Resistances measured between pins 3 and 4 shall be less than 4 ohms.

Recommended actions
1. Detach connectors.
Voltage between pins 1 and 2 on extension cable end shall measure 3.0 to 3.3 Vdc while igniting. You can manually
ignite with the Detectors pop-up window.
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If no voltage is measured, you may need to replace the photomultiplier tube (PMT) module or extension cable.
2. Remove black plate.
Igniter shall glow red while igniting or if you apply 3 Vdc to pins 1 and 2 on burner end. Do not apply more than 3.3. Vdc
to igniter. Do not apply voltage to igniter for more than 20 seconds.

Remove the flame photometric detector (µFPD) burner
Use this procedure and refer to assembly drawing DE-22143 to replace the µFPD burner.

WARNING
EXPLOSION HAZARD
Failure to de-energize the analyzer may cause serious injury or death to personnel.
Do not open when energized or when an explosive atmosphere may be present.
Keep cover tight while circuits are live.

WARNING
BURN HAZARD
Internal components may be hot. Failure to allow the GC to cool down may result in injury to personnel.
Allow the GC to cool down before disassembling any components.
Always wear proper personal protective equipment (PPE) when disassembling the analyzer.
Tools required
■ 7 ⁄64-in. Allen wrench
■ Phillips screwdriver
■ Flathead screwdriver

Procedure
1. Disconnect all power to the unit. Allow at least 10 minutes for the components to cool-down.
2. Remove the explosion-proof dome and the thermal hood.
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3. Use a 7⁄64-in. Allen wrench and remove the fiber cable screws from the µFPD burner mounting plate to disconnect the
cable.
Figure 58: µFPD Burner Disassembly Back View

A.
B.
C.
D.
E.
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µFPD fiber cable clamp
Screws µFPD burner
µFPD fiber cable
Thumb screw
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4. Affix electrical tape to the end of the disconnected fiber cable to prevent debris or moisture contamination.
Figure 59: µFPD Fiber Cable Disassembled

5. Remove the two screws from the µFPD burner housing.
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6. Remove the fiber cable clamp screws and O-ring. Set aside for reassembly.
Figure 60: µFPD Fiber Cable Clamp Dissassembly
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7. Disconnect the air intake, helium intake, and sample lines.
Figure 61: µFPD Ignitor and Intake Lines

A.
B.
C.
D.

Igniter/thermocouple (TC)
Air intake port
Helium intake port
Sample intake port
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8. Loosen the top bulkhead nut and remove the µFPD burner assembly.
Figure 62: µFPD Burner Bulkhead

A. Bulkhead nut
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Install the micro flame photometric detector (µFPD) burner
Use this procedure and refer to assembly drawing DE-22143 to install the µFPD burner.

WARNING
EXPLOSION HAZARD
Failure to de-energize the analyzer may cause serious injury or death to personnel.
Do not open when energized or when an explosive atmosphere may be present.
Keep cover tight while circuits are live.

WARNING
BURN HAZARD
Internal components may be hot. Failure to allow the gas chromatograph (GC) to cool down may result in injury to personnel.
Allow the GC to cool down before disassembling any components.
Always wear proper personal protective equipment (PPE) when disassembling the analyzer.

Tools required
■ 7 ⁄64-in. Allen wrench
■ Phillips screwdriver
■ Flathead screwdriver

Procedure
1. Disconnect all power to the unit.
Allow at least 10 minutes for the components to cool-down.
2. Remove the explosion-proof dome and the thermal hood.
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3. Attach the male fitting of the µFPD burner to the bulkhead nut on the GC. Finger tighten the bulkhead nut.
Figure 63: µFPD Burner Installation

A. µFPD burner
4. Attach and finger tighten two screws/washers on the plastic bracket to center post.
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5. Tighen the bulkhead connector with torque of 20 in. lb.
Figure 64: µFPD Fiber Cable Clamp Assembly

6. Install the fiber cable to the µFPD burner connector and secure with cable clamp.
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7. Install the two screws in the rear of the µFPD burner housing.
Figure 65: µFPD Burner Assembly

A.
B.
C.
D.
E.
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µFPD cable clamp
Screws µFPD burner
µFPD fiber cable
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8. Connect the ignitor, air intake, helium intake, and sample lines.

WARNING
BURN HAZARD
Internal components may be hot. Failure to allow the GC to cool down may result in injury to personnel.
Allow the GC to cool down before disassembling any components.
Always wear proper personal protective equipment (PPE) when disassembling the analyzer.
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Figure 66: µFPD Ignitor and Intake Lines

A. Igniter/TC
B. Air intake port
C. Helium intake port
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D. Sample intake port
9. Replace the thermal hood and the explosion-proof dome.
10. Apply power to the GC.

Remove the micro flame photometric detector photomultiplier tube (µFPD PMT) module

WARNING
EXPLOSION HAZARD
Failure to de-energize the analyzer may cause serious injury or death to personnel.
Do not open when energized or when an explosive atmosphere may be present.
Keep cover tight while circuits are live.

WARNING
BURN HAZARD
Internal components may be hot. Failure to allow the GC to cool down may result in injury to personnel.
Allow the GC to cool down before disassembling any components.
Always wear proper personal protective equipment (PPE) when disassembling the analyzer.

Tools required
■ 7 ⁄64-in. Allen wrench
■ Phillips screwdriver
■ Flathead screwdriver

Procedure
1. Disconnect all power to the unit. Allow at least 10 minutes for the components to cool-down.
2. Remove the explosion-proof dome and the thermal hood.
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3. Use a 7⁄64-in. Allen wrench and loosen the fiber cable screws from the µFPD burner mounting plate to disconnect the cable.
Figure 67: µFPD Burner Disassembly

A.
B.
C.
D.
E.
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4. Affix electrical tape to the end of the disconnected fiber cable to prevent debris or moisture contamination.
Figure 68: µFPD Fiber Cable Disassembled

5. Loosen the screws holding the fiber cable bottom clamp. Slide the bottom clamp up.
Figure 69: µFPD Fiber Cable Clamp Dissassembly
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6. Loosen the thumb screw and carefully lift and tilt the Ultem plate and upper assembly.
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Figure 70: Upper Assembly Tilted
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7. Loosen the fiber cable clamp screws and disconnect the fiber cable from the PMT.
Figure 71: Fiber Cable Disconnected from the µFPD PMT Module

A. Fiber cable
B. Cable clamp
C. Cable clamp screws
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8. Disconnect the wire terminals for J6, J10, and J2.
Figure 72: µFPD PMT Module Connections

A.
B.
C.
D.
E.
F.
G.

J6 - CAN and power signals
J10 - igniter
J2 - thermocouple
USB connector
PMT module bracket screws
Stream manifold screws
Stream manifold

9. Loosen the two Phillips screws from the stream solenoid manifold.
10. Move the entire manifold away from the µFPD PMT module.
11. Use a large flat head screwdriver to loosen the two µFPD PMT module bracket screws.
12. Move the 1/16-in. stainless steel tubing away and pull the µFPD PMT module out of the enclosure.

Install the micro flame photometric detector (µFPD) photo multiplier tube (PMT) module
Tools required
■ 7 ⁄ 64-in. Allen wrench
■ Phillips screwdriver
■ Flathead screwdriver

Procedure
1. Lower the µFPD PMT module into the enclosure.
2. Use a large flathead screwdriver to tighten the two µFPD PMT module bracket screws.
3. Use a Phillips head screwdriver and tighten the two screws to attach the stream solenoid manifold.
4. Attach the J6, J10, and J2 wire terminals to the µFPD PMT module.
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Figure 73: µFPD PMT Module Connections

A.
B.
C.
D.
E.
F.
G.
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J6 - CAN and power signals
J10 - igniter
J2 - thermocouple
USB connector
PMT module bracket screws
Stream manifold screws
Stream manifold
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5. Connect the fiber cable to the µFPD PMT module and tighten the two cable clamp Allen screws.
The shoulder of fiber cable shall be flush with clamp surface to ensure fiber cable is fully inserted into PMT module.
Figure 74: Fiber Cable Connected to the µFPD PMT Module

A. Fiber cable
B. Cable clamp
C. Cable clamp screws
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6. Carefully tilt and lower the Ultem plate and upper assembly. Tighten the thumb screw.
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Figure 75: Upper Assembly Tilted
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7. Remove electrical tape on the end of the fiber cable.
Figure 76: µFPD Fiber Cable Assembly
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8. Insert the fiber cable into the µFPD burner.
Figure 77: µFPD Fiber Cable Assembly

A.
B.
C.
D.
E.

µFPD burner
Fiber cable clamp
Screws µFPD burner
µFPD fiber cable
Thumb screw

9. Tighten the burner fiber cable clamp screws.
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10. Tighten the fiber cable upper clamp screws.
Figure 78: µFPD Fiber Cable Clamp Assembly

11. Replace the insulated cover and the explosion-proof dome.
12. Apply power to the gas chromatograph (GC).

Liquid sample injection valve (LSIV) maintenance
The following procedures detail how to remove and install an LSIV, as well as how to replace an LSIV’s seals.
Install a MAT liquid sample injection valve (LSIV)
You can maintain the LSIV while it is attached to the enclosure. However, it may be easier to perform maintenance with the LSIV
removed from the upper enclosure.

WARNING
This unit operates at high temperature. Failure to follow this precaution may result in injury or death to personnel.
Allow a cool down period of at least ten minutes after shutting down the gas chromatograph (GC) and handle it carefully.
Figure 79: MAT LSIV Components

A.
B.
C.
D.
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Union coupling
Actuation section
Liquid sample connector
Thermal barrier adapter
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For a detailed view of the MAT LSIV’s components, see Figure 82.

Prerequisites
Although, for the most part, you can remove and disassemble the LSIV with traditional tools, such as a wrench or pliers, the
following tools ar eshipped with your LSIV-mounted gas chromatograph (GC).
Figure 80: LSIV Tools

A.
B.
C.
D.

Two 10 mm wrenches
Union coupling wrench
Two 3 mm Allen wrenches
Union coupling spacer

Procedure
1. Install new MAT valve by doing the following:
a) Attach the retaining ring to the MAT LSIV.
b) Slide the MAT LSIV into the mounting hole in the gas chromatograph (GC). Refer to Drawing #DE-20990 in
Engineering drawings.
c) Tighten the retaining ring by twisting it clockwise to secure the MAT LSIV to the GC.
2. Connect the following internal GC gas lines to the MAT LSIV:
a) Connect the carrier gas line to the MAT LSIV.
b) Connect the sample gas line to the MAT LSIV.
3. Place the insulation sleeve around the flash chamber as shown in Drawing #DE-20990.
4. Connect the following external GC gas lines to the MAT LSIV:
a) Liquid Sample IN
b) Liquid Sample Out
c) Air Actuator Inject
d) Air Actuator Retract
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5. Install air solenoid items.
Refer to Drawing #DE-20990.
6. Perform a standard system leak test.
7. Restart the sample flow.
You can now return the GC to service.
Remove the MAT liquid sample injection valve
Inside the upper compartment of the gas chromatograph (GC), there are two insulation covers, which open like clam shells that
slide off of the end of the LSIV, to be removed.

Procedure
1. Disconnect the carrier and sample tubing from the LSIV.
2. Remove the heater and resistance temperature device (RTD) from the heater block.
3. Disconnect sample and air tubing from the outer portions of the LSIV.
4. Unscrew the retaining ring, using a pin spanner wrench or other tool.
With the retaining ring loose, the LSIV assembly is free to be pulled out of the upper enclosure.
Figure 81: Rosemount 700XA after LSIV (A) has been eRmoved

A.
B.
C.
D.

Union coupling
Actuation section
Liquid sample connector
Thermal barrier adapter

Replace liquid sample injection valve (LSIV) seals
Due to the possible damage caused by the presence of solids in the sample stream, combined with the regular, repeated motion of
the injection valve stem, LSIV seals may require annual replacement.
Note
Specific application conditions should dictate the frequency of the seals replacement; monitor analytical performance to determine
appropriate replacement intervals.
Note
ID numbers listed in parentheses refer to “LSIV - Exploded View” in Figure 82.
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Figure 82: LSIV Exploded View

Procedure
1. Halt sample flow and allow time for the LSIV to cool.
2. Remove the actuation portion (26) of the valve by unscrewing the union coupling (19) from the heater section (11), which
should remain attached to the gas chromatograph (GC).
Emerson has provided a union coupling wrench for this purpose.
This will expose the sample flow chamber and the old seals that ride the metering rod (25), which should be treated with
great care to prevent bending or scratching.
3. Pull the sample flow chamber assembly (13) off the metering rod. Remove the two seals (14).
To do this, you may need to push from the opposite sidw with a rod smaller than ⅛ in. (9.5 mm).
4. Place new seals on the sample flow chamber assembly. Press the chamber and seals back over the metering rod.
5. Place the actuation section in position on the heater section’s headpiece.
6. Use the union coupling spacer to ensure that the union coupling is properly aligned with the heater section’s headpiece.
7. Use the union coupling wrench to retighten the union coupling over the heater section.
8. Restart the sample flow.
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Postrequisites
Return the GC to service.
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Maintain the methanator
The optional methanator, which is a catalytic converter, converts otherwise undetectable CO2 and/or CO into methane by adding
hydrogen and heat to the sample. The methanator requires little maintenance.
Order Rosemount Kit PN 2-3-0710-265 for the methanator replacement parts.

WARNING
BURN HAZARD
Enclosure contains hot internal parts. Failure to allow the components to cool down may cause thermal injuries to personnel.
Do not open the enclosure unless the area atmosphere is known to below the ignitable concentration of combustible materials or
unless all equipment has been de-energized for 35 minutes.
Note
Insulate the methanator assembly to prevent heat loss.
Figure 83: Methanator Assembly

A.
B.
C.
D.
E.
F.
G.
H.
I.

Methanator housing cover
Heater insulator (2)
Heater insulator, split
Heater block, methanator bottom
Methanator column
Resistance temperature device (RTD)
Cartridge heater
Heater block, methanator top
Methanator housing

The RTD is replaceable. When replacing it, take care to anchor the RTD cable to the tubing to prevent loosening over time.
To replace the RTD, consult drawing #CE-22715 (see Engineering drawings).
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Measure vent flow
Prerequisites
You will need an accurate flow meter for this measurement.

Procedure
1. Consult the parameter list that was provided with the gas chromatograph (GC) to learn the appropriate flow rate.
2. Attach a flow meter to each measurement vent output on the side of the GC that is labeled MVn, where n is for each vent.
The flow should match the value displayed in the parameter list.

Access electrical components
Emerson designed the gas chromatograph (GC) to operate for long periods of time without needing preventative or regularly
scheduled maintenance.
The enclosure is explosion-proof, dust-proof, water-proof, and flame-proof.

WARNING
EXPLOSION HAZARD
Failure to de-energize the analyzer may cause an explosion and severly injure personnel.
Do not open the enclosure unless the area is known to be non-hazardous or unless all devices within the enclosure have been
de-energized.
Prior to opening the GC, use MON2020 to ensure that there are no configuration or parameter errors.

Procedure
1. Ensure electrical power is disconnected from the GC and the environment is safe.
2. Allow the GC to cool.
3. Unscrew and remove the front panel.
4. Note the location and direction of any board removed. Release the catch(es) and remove/replace the circuit board(s) as
necessary.
5. Close and latch the electronics enclosure door.
6. Apply power to the GC.
Replace AC/DC power supply
The AC/DC power supply is mounted on the left wall of the lower enclosure adjacent to the card cage. To access it, remove the front
panel and the switch panel or local operator interface (LOI) from the lower enclosure.

WARNING
Failure to follow this warning may result in injury or death to personnel or cause damage to equipment.
Disconnect all electrical power to the gas chromatograph (GC) and ensure the area is free of explosive gases.
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Figure 84: AC/DC Power Supply in Lower Compartment

Prerequisites
A Cross point #2 Phillips screw driver is required to remove and replace the AC/DC power supply.

Procedure
1. Remove power to the GC.
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2. Unscrew and remove the front panel.
Figure 85: Removing the Front Panel

3. Unscrew and remove the switch panel or LOI to allow access to the card cage.
Figure 86: Removing the Switch Panel or LOI
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4. If present, remove the clear cover from the card cage.
Figure 87: Card Cage

5. Unplug all the cards in the card cage but do not remove them.
6. Unscrew the three switch panel connector posts. Remove the washers as well.
7. Lift the card cage with the boards and remove it from the lower enclosure.
8. Unscrew and remove the post closest to the power supply.
9. Unplug the connector at the top of the power supply on the left.
10. Unplug the low voltage cable connected along the lower edge of the backplane.
11. Disconnect the ground lead from the power supply at the chassis ground immediately inside the lower enclosure opening.
12. Remove the nut just above the power supply. Twist the power supply free of the attaching stud and lift it from its cradle.
Remove the power supply carefully to avoid damage due to wire interferences.
13. Maneuver the new power supply into the cradle, ensuring that the wires are free to be connected.
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Communications
The Rosemount 700XA has four serial communication ports: Port 0, Port 1, Port 2, and Port 3, which is a dedicated personal
computer (PC) to gas chromatograph (GC) port.
You can set the mode for each of the first three ports to RS232, RS422, or RS485. Normally, the customer specifies these port
configurations at the time of order, and Emerson sets them at the factory. However, the customer can use MON2020 to change
them at any time.
Note
The backplane has two switches located at SW1. The first switch is used for starting the DHCP server. See Connect directly to a
personal computer (PC) using the gas chromatograph's (GC’s) Ethernet1 port for more information. The second switch is reserved
for future use.
The backplane has two Ethernet ports:
Name

Location

Connector type

ETHERNET1

J22

RJ45 (DHCP-enabled)

ETHERNET2

TB11

4-wire terminal block

Maximum distance by communication type
Communication Type

Maximum length

RS-232

50 ft. (15.2 m)

RS-422/RS-485

4000 ft. (1219.2 m)

Ethernet (CAT5)

300 ft. (91.4 m)
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Change the line drivers
The following table lists the relevant traits of the gas chromatograph's (GC's) serial ports.
Port name

Port mode

Terminal block
location on the
backplane

Port 0

RS232

TB1

RS422, RS485

TB2

RS232

TB5

Port 2

RS232

Port 1

RS422, RS485
Port 3 (DB9 connector)

Communication
modes supported

Modbus® ASCII/RTU

TB8

TB9
RS232

J23 (Laptop-PC)

Modbus ASCII/RTU
Direct Connection
through MON2020

Note
You can use Port 3 to connect directly to the personal computer (PC).

WARNING
EXPLOSION HAZARD
Failure to de-energize the analyzer may cause an explosion and severely injure personnel.
Do not open the enclosure unless the area is known to be non-hazardous or unless all devices within the enclosure have been deenergized.

WARNING
HOT SURFACES
Failure to allow the analyzer to cool may cause burns from hot surfaces in the enclosure.
Power down the GC and allow it to cool for at least five minutes.
The factory setting for each port is RS232. To change the setting of a serial portL

Procedure
1. Start MON2020 and connect to the GC.
2. Select Applications → Communication.
The Communication window displays.
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3. Select the appropriate mode from the Port drop-down list for the appropriate serial port.
The options are:
■ RS232
■ RS485
■ RS422
Figure 88: MON2020 Communication Settings

4. Click OK.
5. Close MON2020.
6. Locate and remove the base in/out (I/O) board, which is located in the card cage in the GC’s lower enclosure.
7. Consult Figure 89, which shows the correct switch settings.
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Figure 89: Base I/O Board (PN 7A00403G01/G02)

A. SW10 - ON position - factory setting
8. To enable line termination for a serial port, set the appropriate port switch on SW10 to the bottom position.
9. Replace the Base I/O board in the card cage.
10. Consult Table 7, which shows the correct termination block wiring for each mode and port.
Table 7: Port Configurations
The first column lists the port number; the first row lists the communications mode. The table cell at which the desired port and the
desired mode intersect contains the appropriate wiring for that configuration.
RS232

RS422 (full duplex/4-wire)

RS485 (half duplex/2-wire)

N/A

N/A

Port 0

Port 1
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Table 7: Port Configurations (continued)
RS232

RS422 (full duplex/4-wire)

RS485 (half duplex/2-wire)

Port 2
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11. Access the backplane and see Figure 90 to locate the appropriate terminal blocks:
Figure 90: RS232 and RS485, TB1 and TB2 on the Backplane

A.
B.
C.
D.
E.

TB1, Serial Port 0, RS232
TB2, Serial Port 0, RS422/485
TB5, Serial Port 1, RS232
TB8, Serial Port 2, RS232
TB9, Serial Port 2, RS422/485

12. Once the appropriate termination blocks are wired correctly, close and secure the electronics enclosure door, and apply
power to the GC.
Install optional RS232 serial ports
You can install an optional RS232 board in one or both of the expansion in/out (I/O) slots provided on the gas chromatograph's
(GC's) card cage in the electronics enclosure.
You can use this extra port for Modbus® ASCII/RTU communications or to connect directly to a computer installed with MON2020.
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Figure 91: RS232 Connections

Terminal

Label

Definition

1

RX

Receive

2

TX

Transmit

3

RTS

Request to send

4

DTR

Data termininal ready

5

GND

Ground

Procedure
1. Start MON2020 and connect to the GC.
2. Select Tools → I/O Cards.
3. Identify the appropriate card slot under the Label column and then select Communications module - RS232 from the
appropriate Card Type drop-down list.
4. Click OK.
5. Turn off the GC.
6. Install the RS232 board into the appropriate I/O card slot in the GC’s card cage.
7. Close and secure the electronics enclosure door.
8. Apply power to start the GC.
Install an optional RS485/RS422 serial port card
You can install an optional RS485 board in one or both of the expansion in/out (I/O) slots provided with the gas chromatograph's
(GC's) card cage in the electronics enclosure. You can configure this card to RS422 (four-wire) or RS485 (two-wire) mode.
RS485 mode is the default setting; to configure the card for RS422 mode, see Configuring the optional RS485 serial port to function
as an RS422 serial port. Also see Emerson.com/ROC800-Series.
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Procedure
1. Start MON2020 and connect to the GC.
2. Select I/O Cards from the Tools menu.
The I/O Cards window displays.
3. Identify the appropriate card slot under the Label column and then select Communications module - RS422/485 from the
appropriate Card Type drop-down list.
Figure 92: MON2020 I/O Cards

4. Click OK.
5. Turn off the GC.
6. Install the RS485/RS422 serial port card into the appropriate expansion slot in the GC’s card cage.
7. Replace the card cage cover, local operator interface (LOI) board, and enclosure cover. Start the GC.
Configuring the optional RS485 serial port to function as an RS422 serial port
See Table 8 for the correct jumper settings to configure the optional RS485 serial port to function as an RS422 serial port:
Table 8: Configuring the Serial Connections for RS485/RS422 Serial Communications
Jumpers

RS485 (half duplex/2-wire)

RS422 (full duplex/4-wire)

J3

Half

Full

J5

Half

Full

Termination IN

Termination OUT

J4

In

Out

J6

In

Out

TB1 wire terminals

RS485 (half duplex/2-wire)

RS422 (full duplex/4-wire)

A

RxTx+

Rx+

B

RxTx-

Rx-

Y

NC

Tx+

Z

NC

Tx-
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Analog inputs and outputs
Use MON2020 to calibrate or adjust the analog outputs.
However, make sure to measure these outputs with a calibrated digital meter upon initial installation at zero scale and full scale.
Then use MON2020 to set the sapn so that it represents values from 0 to 100 percent of the user-defined units in use.
Nominally, calibration is made within a range of 4-20 milliamperes (mA) output from each analog channel. To set a reference point
to trigger an alarm condition, configure zero scale calibration with a 0 mA output and full scale calibration set up to 22.5 mA
output.
If there is reason to suspect that the span on any particular channel might be off after a period of time and heavy use, then
recalibrate the analog output for that channel.
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Analog output adjustment
Emerson sets the initial analog output adjustments at the factory before shipment at standard values (4-20 mA). You many need to
check and/or adjust these values depending on output cabling/impedance.
The adjustment may require two people if the units are some distance apart. It requires a calibrated digital meter to check the zero
and full scale values at the receiving end. You can use MON2020 to adjust the scale or span value.
You can use different engineering units, volts, and percentages to calibrate the analog outputs.

Upgrading the embedded software
The base GC firmware performs functions similar to operating systems such as DOS, Windows™, or Linux®. The base GC firmware
provides the basic resources and interfaces to run the customer's applications. There is no direct user-level interface to the
firmware.
If you need to upgrade the firmware to your system, refer to the MON2020 Software for Gas Chromatographs Reference Manual for
additional information.
The GC’s applications use the tools provided by firmware to perform the desired gas chromatograph applications for the user.
There are different applications to facilitate different gas chromatographic needs. To load a new application or to upgrade an
existing application, refer to the MON2020 Software for Gas Chromatographs Reference Manual for details.

Troubleshooting
The information is arranged either by major subsystems or by major functions of the gas chromatograph (GC).
Note
Correct all alarms before recalibrating.

Hardware alarms
Use LTLOI Failure through Flame Photometric Detector Board 1 Comm Failure to identify the alarm, potential cause, and solution
for the problem.

LTLOI Failure
Recommended actions
1. Power the gas chromatograph (GC) down completely.
2. Check that the local operator interface (LOI) is connected to the backplane board at one end and the LOI board at the
other end.
3. Power up the GC.
4. If the message appears again, replace the board.

Maintenance Mode
A technician has put the gas chromatograph (GC) into Maintenance mode for servicing.

Recommended action
To disable Maintenance mode, deselect the Maintenance Mode check box in the System dialog.
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Power Failure
Potential cause
The gas chromatograph (GC) has experienced a restart, caused by a power failure, since alarms were last cleared.

Recommended action
Allow the GC to automatically restart in Warm Start mode.
During Warm Start mode, the GC does the following:
a. Waits for the heaters to stabilize.
b. Purges the sample loop.
c. Actuates the valves for two cycles.
After completing these actions, the GC switches to auto-sequence mode.

User Calculation Failure
The gas chromatograph (GC) has detected one or more errors while parsing a user-defined calculation.

Potential cause
This usually happens when a user-defined calculation attempts to use a system variable that does not exist.

Recommended action
Fix the calculation that is referring to the undefined system variable.

Low Battery Voltage
The gas chromatograph (GC) has detected a low battery voltage on the central processing unit (CPU) board.

Recommended actions
Replace the CPU board immediately to avoid losing GC configuration data.
a) Save the diagnostic data file. In MON2020, go to Tools → Save Diagnostic Data.
b) Power down the GC.
c) Ensure that SW7 on the CPU board is in the On position.
d) Replace the CPU board.
e) Restore configuration back to the GC. In MON2020, go to File → Restore Configuration to GC..

Preamp Board 1 or Preamp Board 2 Comm Failure
The gas chromatograph (GC) cannot detect the preamp board.

Recommended actions
1. Power the GC down completely.
2. Check that the board is properly seated in the correct slot (Preamp1 or Preamp2) on the backplane.
In MON2020, select Hardware → Installed Hardware for hardware slot locations.
3. Power up the GC.
4. If the message appears again, replace the preamp board.

Flame ionization detector (FID), flame photometric detector (FPD), or µFPDG2 (FPDG2) Failure
Alert message identifies FID/FPD or FPD G2 hardware. The FID/FPD or µFPD is not detected.
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Recommended actions
1. Power the gas chromatograph (GC) down completely.
2. Check that the board is properly seated in the correct slot (Preamp 2) on the backplane.
3. Power up the GC.
4. If the message appears again, for the FID, replace the electrometer. For the µFPD, replace the photomultiplier tube
(PMT) module.

Heater Solenoid Board (1 or 2) Comm Failure
Heater/solenoid board not detected.

Recommended actions
1. Power the gas chromatograph (GC) down completely.
2. Check that the board is properly seated in the correct slot (Heater Solenoid 1 or Heater Solenoid 2) on the backplane.
3. Power up the GC.
4. If message appears again, replace the heater/solenoid board.

Base in/out (IO) Board Comm Failure
Base I/O (multifunction I/O) board not detected.

Recommended actions
1. Power the gas chromatograph (GC) down completely.
2. Check that the board is properly seated in the correct slot on the backplane.
3. Power up the GC.
4. If message appears again, replace the base I/O board.

Stream Skipped
One or more streams in the stream sequence cannot be analyzed, because their Usage option is set to Unused.

Recommended actions
In MON2020, do one of the following:
• Remove the unused stream(s) from the stream sequence.
• Change the Usage option of the stream(s) in the Streams dialog to something other than Unused.

GC Idle
Potential cause
The gas chromatograph (GC) has been placed in Idle mode and is not running an analysis.

Heater (1-8) Out of Range
The gas chromatograph (GC) has failed to regulate heater zone temperatures for the indicated heater to within preset limits.

Recommended actions
1. Check temperatures within the GC, using MON2020 or the local operator interface (LOI).
Be aware that the GC may generate this alarm following start-up or if the set point has been changed.
2. Check wiring, looking for splits or loose connections at the termination board (for both the heaters and the resistance
temperature devices [RTDs]).
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3. If necessary, replace the defective heater and/or RTD.

Flame Out
Detector 1 Flame Out
The flame ionization detector (FID) or flame photometric detector (FPD) will not light or has extinguished.

Potential cause
The FID is out.

Recommended actions
1. Use the front switch panel or MON2020 to ignite the flame.
2. If unable to sustain the flame, confirm that both fuel and air cylinders are connected and contain sufficient pressure.
3. Confirm that the fuel and set points are set to achieve the factory-desired mixture.
4. Confirm that there is no blockage at the FID exhaust outlet, such as a cap or ice.
5. Check that the wiring connections are secure for the FID, both on the FID cap and at the termination board.
6. If necessary, replace the FID module.

To ignite the flame manually:
1. Connect the air to the inlet and slowly bring the pressure to 60 psig (413.7 kPa).
2. Connect hydrogen to the inlet and slowly bring the inlet pressure to 60 psig (413.7 kPa).
3. Remove tubing from the flame cell exhaust and use a digital flow meter to adjust the air control valve until you obtain a
reading of 160 cc/min.
4. Turn off the air supply.
5. Set the auto relight switch (S1) on the electrometer PCB to the OVERRIDE position.
6. Use the digital flow meter to adjust the hydrogen control valve until you obtain a reading of 100 cc/min.
7. Turn on the air supply.
8. Set the auto relight switch (S1) on the electrometer PCB to the RUN position.
The auto relight sequence begins as follows:
a. The light-emitting diode (LED) on the electrometer comes on after 10 seconds, and the glow plug fitted to the
side of the flame cell is supplied a voltage.
b. After another five seconds, the hydrogen shut-off valve operates.
c. The gas mixture ignites.
d. If the flame does not light in five seconds, the electrometer de-energizes the hydrogen shut-off valve to stop
the flow into the flame cell.
e. The flame cell is purged with air and nitrogen carrier gas.
f. The process starts again (up to 10 times) until the flame stays lit.
g. If the flame does not stay let, the LED flashes. If the alarm output is linked to the 2350A controller discrete
input, an alarm is present on the controller.
h. Set the auto relight switch (S1) on the electrometer PCB to the RESET position and then back to the RUN
position.
i. The relight sequence restarts.

Potential cause
The FPD is out.
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Recommended actions
1. In MON2020, click Open H2 Valve.
The H2 Valve Cur State field changes to Open.
2. Click Ignite.
The Flame Status field changes when the internal temperature exceeds the value set in the Flame On Sense Temp field.
Note
If the Flame Ignition field is set to Auto, the GC will automatically restart the flow if it goes out.
3. If the GC fails to light after resetting the electrometer, recheck the air and hydrogen flow.
For more information on the FPD, see Micro flame photometric detector (µFPD).

Flame Over Temperature
Detector 1 flame over temperature.
The flame ionization detector (FID) flame temperature is above safe limits set at the factory. The FID flame has been extinguished,
the fuel supply valve closed, and automatic analyses halted.

Recommended actions
1. Confirm that both fuel and air cylinders are connected and contain sufficient pressure.
2. Confirm that fuel and air set points are set to achieve desired mixture.
3. Use the local operator interface (LOI) or MON2020 to ignite the FID.

Detector (1-3) Scaling Factor Failure
The gas chromatograph (GC) detected an excess scaling factor deviation for the detector.

Recommended action
Replace the preamp board.
The preamp boards for detectors 1 and 2 are located in Preamp 1.
The preamp board for detector 3 is located in Preamp 2.

No sample flow (1 or 2)
This alarm applies to the optional sample flow switch. The corresponding flow switch indicates that there is no sample flow in the
gas chromatograph (GC).

Recommended actions
Check the sample gas rotameter in the sample conditioning system for flow.
• If no gas flow or no rotameter is present:
a. Confirm that there is gas flow at the sample point location.
b. Ensure that the sample valves in the sample conditioning system are open.
c. Ensure that the bypass return vent path is free of obstruction.
d. Confirm that the sample line is connected from the sample point to the GC's sample conditioning system and is free
of obstructions.
e. Close the valve at the sample tap, remove pressure from the line, and check the filters at the probe, the sample
conditioning system, or both. If they are filled with liquids or particulates, replace the filtering elements.
• If automatic stream selection valves are present, confirm that they are operating properly.
• If a slight sample gas flow is present at the rotameter in the sample conditioning system, drain or replace all filters.
• If you observe flow in the rotameter, replace the sample flow switch.
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Low Carrier Pressure (1-4)
Input carrier pressure for the detector is below the preset limit.

Recommended actions
1. Check that the carrier cylinder pressure is at least 10 psig (68.9 kPa) above the mechanical regulator set point.
2. If input carrier pressure is low, check the carrier cylinder pressure.
3. Replace the carrier gas cylinder if required.

Analog Input (1-10) High Signal
Measured value for the indicated analog input is greater than the user-defined full scale range.

Analog Input (1-10) Low Signal
Measured value for the indicated analog input is lower than the user-defined full scale range.

Analog Output (1-10) High Signal
Measured value for the indicated analog output is greater than the user-defined full scale range.

Analog Output (1-10) Low Signal
Measured value for the analog output is lower than the user-defined zero range.

Stream (1-20) Validation Failure
The most recent validation sequence for the indicated stream failed.

Recommended actions
1. Ensure that the validation gas cylinder isolation valves are open.
2. Ensure that the validation gas regulators are set properly.
3. If the validation gas regulator pressure is below the set point, replace the gas bottle with a full one.
4. If the gas used for validation is the same as the gas that is used for calibration, ensure that the cylinder gas composition
value listed on the cylinder's tag or on the certificate of analysis received from the supplier matches the value displayed
in MON2020's Component Data table.

Stream (1-20) RF Deviation
The most recent calibration sequence failed.

Recommended actions
1. Ensure that the calibration gas cylinder isolation valves are open.
2. Ensure that the calibration gas regulators' pressures are set properly and that the cylinder is not below the set point. If
the cylinder is below the set point, replace it with a full cylinder
3. Verify that the calibration cylinder gas composition value listed on the cylinder tag or on the certificate of analysis
received from supplier matches the calibration cylinder gas composition value displayed in MON2020's Component
Data table. If there is a mismatch, edit the Component Data table to reflect the correct value. Re-run the calibration
sequence.
4. If the calibration is still unsuccessful, contact your Emerson representative.
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Energy Value Invalid
For each configured analysis (Analysis n label added if it is a concurrent analysis configuration), perform a check of the analyzed
energy value of the calibration gas against the known value as part of the warm start sequence.
The Energy Value Invalid alarm is raised to instruct the associated DCS that the analyzer has failed and all data should be ignored
until a successful calibration run has been performed to verify the analysis of the gas chromatograph (GC).
On completing warm-up, the GC performs a single analysis of the calibration stream. Using results of the analysis, the GC calculates
the energy value and compares it against the previously entered value stored in the tables.
If the calculated energy value is within the allowable limits set up by the operator, the Energy Value Invalid alarm is cleared, and the
GC returns to normal operation; otherwise, the Energy Value Invalid alarm remains active.

Recommended actions
1. Ensure that correct Calibration Gas Energy Value and limits have been entered in the Component Data Table → Edit
Energy Value dialog window.
2. Ensure the calibration gas bottle is open and not low or empty.
3. Check analyzed concentration results for each individual component versus calibration gas concentrations in the
Component Data table.
4. Adjust timed events if necessary.

Calibration Energy Check Fail
After completing a calibration sequence, the gas chromatograph (GC) performs a calibration gas energy value check.
If the calculated energy value fails the check, the software automatically runs the calibration again.
If the second calibration also fails this check, the GC raises a system alarm, Calibration Energy Value Check Fail.

Recommended actions
1. Ensure the calibration gas bottle is open and not low or empty.
2. Check analyzed concentration results for each individual component versus calibration gas concentrations in the
Component Data table.
3. Adjust timed events if necessary.

Stored Data Integrity Failure
Archived results, event logs, and alarm logs are stored as records in the instrument database along with a CRC16 checksum. When
the data is retrieved, the gas chromatograph (GC) recomputes the checksum and checks the stored checksum against the
calculated checksum. If they don't match, the GC raises a Stored Data Integrity Failure alarm.

Recommended actions
1. Reset archives using the dialog box under MON2020 → Logs/Reports Menu.
Note
All archived data in the GC will be lost.
2. Replace the central processing unit (CPU) board.

ROM Checksum Failure
The gas chromatograph (GC) recomputes the firmware checksum at periodic intervals. If the calculated checksum varies from the
original value, the GC raises a ROM Checksum Failure alarm.

Recommended actions
1. Re-flash the GC controller firmware in MON2020 Tools → Upgrade Firmware.
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Note
All archived data in the GC will be lost.
2. Replace the central processing unit (CPU) board.

Sample Fluid Unavailable
The stream switching sequence defined in the Custom Logic configuration failed to successfully execute. <Analysis n Label> is added
for concurrent analysis configurations.

Recommended action
Confirm proper operation of all sample system components and ability to provide adequate sample flow.

Flame Photometric Detector Board 1 Comm Failure
The gas chromatograph (GC) cannot detect the micro flame photometric detector (µFPD).

Recommended actions
1. Power the GC down completely.
2. Check that all cables are securely connected to the FPD interface module.
3. Power up the GC.
4. If the message appears again, replace the FPD photomultiplier tube (PMT) module.

No power to flame photometric detector (FPD)
Recommended actions
1. Check cable (7A00454G01), connectors, and terminals.
2. Check flex cable.
3. Check that the voltage from the lower terminal is 25 Vdc.

Can't ignite flame photometric detector (FPD)
Recommended actions
1. Check the flow.
Gas flow rates are measured at exhaust while oven reaches to set temperature. The air flow should be 150 cc/min, and
the H2 flow should be 100 cc/min.
2. Check igniter resistance in ohms.
The resistance should be 0.6 to 1 ohms.
3. Ensure that the flame temperature is > 493.1 °F (220 °C) when the ignitor is first turned on and then goes down to
413.1 °F (140 °C).
4. Ensure that there are no restrictions at the exhaust line.

No peaks showing
Recommended actions
1. Ensure that the flame is on.
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2. Ensure that the sample gas has been injected.
3. Check carrier gas flow.
4. Check sample flow.
5. Check columns.

Small peaks
Recommended actions
1. Clean the burner windows with isopropyl alcohol (IPA).
2. Adjust the air to H2 flow rate to between 1.3 and 1.7.
3. Ensure that the flame photometric detector (FPD) high voltage is 800 Vdc for side cart option of FPD.

No temperature readings
Recommended action
Check the thermocouple.
The thermocouple's resistance should be less than 3.5 ohms.

Noisy baseline
Recommended action
Click Autozero to adjust the baseline.

Peak clipping
Recommended action
Click Autozero to adjust the baseline.

Test points
The backplane has a set of test points that allow you to measure the voltage output of the base in/out (I/O) card.
Each test point is labeled with a voltage value that, when measured with a voltmeter, should give a measurement equal to what is
displayed on the label. A reading that does not match this label may indicate a faulty base I/O card. Try swapping out the suspect
card with a different one, and take another measurement. To get a measurement for a test point, touch the voltmeter’s negative
probe to the DGND test point and touch the voltmeter’s positive probe to the desired test point.
The test points are associated with the following gas chromatograph (GC) components:
Table 9: Backplane Test Points and Associated GC Components
Test Point

GC Component

Tolerances

VIN

Voltage in

N/A

I RTN

Isolated return

N/A
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Table 9: Backplane Test Points and Associated GC Components (continued)
Test Point

GC Component

Tolerances

I 24V (Regulated)

Isolated voltage (loop power)

24 V (±2.4 V)

24V (Regulated)

GC power

24 V (±2.4 V)

17V5

Preamp (input for the bridge circuit)

17.5 V ±0.5 V

12V

Optional I/O cards

12 V ±0.6 V

5V1

System chips

5.1 V ±0.25 V

3V4

System chips

3.4 V ±0.15 V

FVIN

Field voltage input

0V±3V

FVGND

Field voltage ground

21 V ± 30 V

The input voltage range for the DC/DC power supply is between 21 and 30 volts. The input range for AC/DC power supply is 90 264 volts (auto-ranging).

Voltage light-emitting diodes (LEDs)
A set of LEDs can be found above the test points .
These LEDs are a quick way to visually inspect the voltage status of some of the gas chromatograph's (GC's) electrical components.
The following LEDs are associated with the following GC components:
VIN (fuse open)

Glows red when the fuse has blown or been removed;
otherwise, it is not lit.

1 RTN - 24 loop
(Power)

Glows green when the power supply for the analog outputs is
functioning properly; otherwise it is not lit.

24V regulated (GC
power)

Glows green when the GC power is functioning properly;
otherwise, it is not lit.

17V (Input for the
preamp)

Glows green when the power supply for the preamp is
functioning properly; otherwise, it is not lit.

12V (Input for the
I/O cards0

Glows green when thee optional ROC expansion card's power
supply is functioning properly; otherwise, it is not lit.

5V1

Glows greeen when the system chip's 5.1 V power supply is
functioning properly; otherwise, it is not lit.

3V4

Glows green when the 3.4 V power supply for the system chips
is functioning properly; otherwise, it is not lit.
Note
Some boards have different shades of green for this LED.

Power ON

Glows green when the GC is on; otherwise, it is not lit.

Monitoring the detector(s) and columns temperature
Use MON2020 to monitor the temperature of the detector(s) and columns to determine if the GC is thermally stable.
When connected to the GC via MON2020, select Hardware → Heaters to access this function.
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When viewing the Heater window, the typical heater configuration is as follows:
The Temperature column on the Heaters window displays the current temperature; the Current PWM column displays the
percentage of power being used to run the heater.
The settings and values shown in the Heaters window and described below, are preset at the factory and are based on the specific
customer application. Do not change these values unless application engineering or or customer service personnel recommend it
or as part of a factory application requirement.
Function

Typical setting

Detector(s) or analytical block temperature

176 °F (80 °C)

Oven temperature

176 °F (80 °C)

Spare
Or, Methanator
Or, LSIV

N/A
572 °F (300 °C)
302 °F (150 °C)
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